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Overview
Welcome to the Ship Structure Detail Design User's Guide. This guide is intended for users who need to become 
quickly familiar with the Ship Structure Detail Design Version 5 product.

This overview provides the following information:

●     Ship Structure Detail Design in a nutshell

●     Before reading this guide

●     Getting the most out of this guide

●     Accessing sample documents

●     Conventions used in this guide

Ship Structure Detail Design in a Nutshell

Version 5 Ship Structure Detail Design  provides a set of tools for structure designers who must complete 
their functional design and carry out their detailed design.

The overall ship design project goes through a number of different phases from conceptual design through 
functional and detail design to extraction of deliverables. This product addresses detail design requirements for 
the shipbuilding industry. In particular, it lets you:

●     Split your functional design into blocks

●     Add secondary structures

●     Capture functional connectivity and physically implement connections by means of piece parts and joints

●     Create design features such as endcuts, slots, cutouts, etc.

●     Capture weld joint locations and efficiency

●     Generate plates and shapes to initiate the manufacturing view.

Ship Structure Detail Design makes wide-scale use of knowledgeware capabilities to implement connections and 
create design features. It includes tools that speed up the design process, such as the ability to rapidly copy 
small repetitive assemblies or to quickly subdivide a large part into the separate plates from which it would be 
fabricated as well as sample catalogs of slots, endcuts and small assemblies.

All Ship Structure Detail Design commands share a consistent Windows graphical interface which reduces 
training time and greatly increases ease of use.

As a scalable product, Ship Structure Detail Design can be used with other Version 5 products such as 
Generative Shape Design, Generative Drafting and knowledgeware products.

Before Reading this Guide



Before reading this book, you should be familiar with basic Version 5 concepts such as document windows, 

standard and view toolbars. We therefore recommend that you read the Infrastructure User's Guide that 

describes generic capabilities common to all Version 5 products.

You may also like to read the following complementary product guides, for which the appropriate license is 
required:

●     Generative Shape Design User's Guide

●     Generative Drafting User's Guide.

Getting the Most Out of this Guide

To get the most out of this guide, we suggest that you start reading and performing the step-by-step tutorial 

Getting Started. This tutorial will let you get acquainted with the product.

Once you have finished, you should move on to the User Task section of this guide. This steps you through basic 
procedures and includes useful tips for getting the most out of the product.

The Workbench Description, which describes the Ship Structure Detail Design-dedicated toolbar will also 
certainly prove useful. A Glossary of terms specific to Ship Structure Detail Design and a Reference Information 
section for administrators have also been included in this guide.

Navigating in the Split View mode is recommended. This mode offers a framed layout allowing direct access 
from the table of contents to the information.

Accessing Sample Documents

A sample document is provided for the Getting Started tutorial. It is located in the online/sddug/samples 

folder. This sample document can profitably be used as a basis for other scenarios in this guide.



Conventions
Certain conventions are used in CATIA, ENOVIA & DELMIA documentation to help you recognize and understand 
important concepts and specifications. 

Graphic Conventions

The three categories of graphic conventions used are as follows:

●     Graphic conventions structuring the tasks

●     Graphic conventions indicating the configuration required

●     Graphic conventions used in the table of contents

Graphic Conventions Structuring the Tasks

Graphic conventions structuring the tasks are denoted as follows:

This icon... Identifies...

estimated time to accomplish a task

a target of a task

the prerequisites

the start of the scenario

a tip

a warning

information

basic concepts

methodology

reference information

information regarding settings, customization, etc.

the end of a task



functionalities that are new or enhanced with this release

allows you to switch back to the full-window viewing mode

Graphic Conventions Indicating the Configuration Required 

Graphic conventions indicating the configuration required are denoted as follows:

This icon... Indicates functions that are... 

specific to the P1 configuration

specific to the P2 configuration

specific to the P3 configuration

Graphic Conventions Used in the Table of Contents

Graphic conventions used in the table of contents are denoted as follows:

This icon... Gives access to...

Site Map

Split View Mode

What's New?

Overview

Getting Started

Basic Tasks

User Tasks or Advanced Tasks

Interoperability

Workbench Description

Customizing

Administration Tasks

Reference



Methodology

Frequently Asked Questions

Glossary

Index

Text Conventions

The following text conventions are used:

●     The titles of CATIA, ENOVIA and DELMIA documents appear in this manner throughout the text.

●     File -> New identifies the commands to be used.

●     Enhancements are identified by a blue-colored background on the text.

How to Use the Mouse

The use of the mouse differs according to the type of action you need to perform.

Use this
mouse button... Whenever you read...

 
●     Select (menus, commands, geometry in graphics area, ...)

●     Click (icons, dialog box buttons, tabs, selection of a location in the document window, 
...)

●     Double-click

●     Shift-click

●     Ctrl-click

●     Check (check boxes)

●     Drag

●     Drag and drop (icons onto objects, objects onto objects)

●     Drag

●     Move



●     Right-click (to select contextual menu)



What's New?
No enhancements in this release



Getting Started
This tutorial will guide you step-by-step through your first Ship Structure Detail Design session, allowing 
you to get acquainted with the product.

You will need a CATIA Version 5 session and should be familiar with basic concepts such as document 
windows, standard and view toolbars.

You should be able to complete this tutorial in about 20 to 30 minutes.

Opening the Product to Work On
Adding Plating

Adding Stiffening
Adding Slots & Trimming Stiffening

Adding Openings 



Opening the Product to Work On
This first task shows you how to open a CATProduct, enter the Structure Detail Design workbench and 
customize your settings.

1. Select Equipment & Systems -> Ship Structure Detail Design from the Start menu. 

The Ship Structure Detail Design workbench is loaded and an empty CATProduct document is 
opened.

2. Select File -> Open then select the GettingStarted.CATProduct document.

The document shows the detail design block  in which you will be working. A certain number of 
functional design items have been processed using Block Scheme, Block and Split by Block 
commands to create equivalent detail design items. 

Note: In building this document, the Keep link with selected objects option was checked. Any 
detailed design items you now create will therefore be associated to entities used to create them.

http://pc220dsa/MARCXR15/doc/online/sddug_C2/samples/GettingStarted.CATProduct


 3. Customize settings to display parameters and relations in the specification tree:
●     Select Tools -> Options -> Infrastructure -> Product Structure, Tree Customization 

tab

●     Set both Parameters and Relations options to Yes to visualize parameters and relations in 
products 

●     Select Part Infrastructure in the Infrastructure category, then the Display tab

●     Check Parameters to visualize parameters in parts

●     Select Parameters and Measure in the General category, then the Knowledge tab

●     Check With value to display parameters with values.

4. Customize standard CATIA views to suit shipbuilding conventions.
 5. If desired, hide the block to lighten the document and make your selections easier.

  

You are now ready to start. Your first task will be to create a new floor plate.

  



Adding Plating
This task shows you how to add a new floor plate.

1. Click the Plating  icon. 

The Plating dialog box is displayed.

2. Define the associated class: 
●     Click Change... opposite Object class.

The Class Browser opens.

●     Expand the Class Browser tree and select Transverse Bulkhead, then click OK in the Class 
Browser.



 
3. Define the properties of the new floor plate: 

●     Click the Design table icon:
The Design Table dialog box appears.

●     Select the desired thickness, for example 15mm.

●     Click OK.

●     Set the material to Steel A36 in the Material drop-down list.

4. Specify the molded surface support of the new floor plate: Select cross plane Plane.9 for example.



The Paneling Molded Surface dialog box opens. 

5. Select limits to define the contour and watch your molded surface being built. 

Note: It is important to select limits in a certain order. 

●     Select the top deck 

●     Select the hull form 

●     Click Other Side of First Limit to define the contour in the downward direction

●     Select the bottom deck

●     Click Other Side of Last Limit

●     Select a zx plane.



The contour of the floor plate is green indicating that it is correct.

6. Click OK in the Paneling Molded Surface dialog box. 

The floor plate is visualized in the geometry area with an arrow indicating the direction of plate 
thickness.



7. Click OK in the Plating dialog box to create your floor plate.

8. Place the hull form and bottom deck with stiffeners in No Show to view only the top deck and floor 
plate. 

You will now stiffen the floor plate.

  



Adding Stiffening
This task shows you how to stiffen the floor plate you just created.

1. Double-click the paneling system under which the floor plate is created.

2. Click the Stiffening  icon.

The Stiffening dialog box is displayed.

3. Define the associated class: 
●     Click Change... opposite 

Object class.

The Class Browser opens.

●     Expand the Class Browser tree 
and select Transverse 
Bulkhead Vertical Stiffening, 
then click OK in the Class 
Browser.



 
4. In the Section field, define the section you want to use, in our case WT18X179.5 

●     Select Other section...
The Catalog Browser opens previewing the contents of the current catalog, by default the 
AISC_BigScale catalog.

●     Double-click the Tee standard type.

●     Browse the list of shapes and selection section WT18X179.5.

●     Click OK.



5. Define other stiffening properties: 
●     Click the drop-down arrow opposite the Material field and select the desired material-grade 

combination. In this case, Steel A36.

●     Right-click in the Anchor point field and select User from the contextual menu, then set the 
anchor point to WebSideRight.

●     Keep the default orientation. 

6. Define the web support along which the stiffening section will be swept: 

Click the Web support field then select longitudinal planes corresponding to existing deck stiffeners 
to align floor plate stiffeners to existing stiffeners.

7. Click OK when done.



  

The floor plate is stiffened as specified. You will now add slots to the floor plate for passage of deck 
stiffeners.

  



Adding Slots & Trimming Stiffening
This task shows you how to: 

●     Add slots to the floor plate for the passage of deck stiffeners

●     Trim floor plate stiffening to allow for welding

●     Create corner brackets connecting the deck to the floor plate.

Slots require closed contours and user features to position them.
  

Adding Slots
1. Click the Slot  icon.

The Slot dialog box is displayed.

2. Select the floor plate then click the Add button. 

The Create A Slot dialog box appears.



3. Select all stiffeners passing through the floor plate.

4. Click the Catalog Browser icon to open the catalog containing the available slot types.

Note: The catalog Browser opens at the appropriate chapter, in our case Tees.
5. In the Catalog Selection for Slot dialog box, navigate to the family (Clearance Cut)that contains the 

appropriate slot type, for example CC-10, then click OK to select the slot.



  

6. Click OK in the Create A Slot dialog box that re-appears.

Slots are created for each stiffener passing through the floor plate. Slots are identified in the Slot 
dialog box that appears.

  

7. Click OK in the Slot dialog box to confirm.



Trimming Stiffening

You will now cut back floor plate stiffening to top deck stiffening.
1. Click the Cutback  icon.

The Cutback dialog box opens. The Trim to plane 
option is the default option.

2. Select one of the floor plate stiffening systems. 

This is the stiffening you want to trim.

3. Select the flange face of the corresponding deck 
stiffener.

4. Click OK to trim the floor plate stiffening to the flange 
face of the deck stiffener and if necessary, update.

5. Repeat for other floor plate stiffening.



Creating Corner Brackets

Brackets are small assemblies and are created using assembly templates.
 1. Click the Small Assemblies  icon.

The Catalog Selection for Small Assemblies dialog box opens.

  



 2. Double-click the Brackets chapter and select knee bracket.

  



 3. Click OK to close the Catalog Selection for Small Assemblies dialog box.

The Insert Object dialog box opens.

  



 4. Select one of the deck stiffening systems (shape 1) to position the small assembly.

The name appears in the Selected column.

 5. Select the corresponding floor plate stiffening system (shape 2).

 6. Click OK when done.

The bracket is created.

  

 7. Repeat to create brackets connecting other sets of floor plate and deck stiffening systems.



  

  



Adding Openings
This task shows you how to add an opening to the floor plate. 

Openings require closed contours and user features to position them.
1. Double-click the floor plate paneling to activate it.

2. Click the Opening  icon.

The Opening dialog box is displayed. Keep the default object class.

3. Click the Strategy drop-down arrow 
in the position area and select Two 
planes, then click Create...

The Insert Object dialog box opens.

The molded surface of the floor plate 
is selected as the support plane and 
is indicated  in the geometry area.



 4. Select the two planes that will 
position the opening, then click 
Preview to view the results in the 
geometry area.

  

 5. Click OK to return to the Opening dialog box.
 6. Check the Support top view option in the Opening dialog box to get a top view of the 3D model.



  

 
 7. Use the green manipulators to adjust the position of the opening.
  

8. Set the contour Type to Sketcher and click the sketcher icon.
9. Sketch your shape in the Sketcher workbench, then exit.

The name of the sketch appears in the Shape field.
10. If necessary, adjust the position of the opening again, click Preview in the Opening dialog box.

  



 11. Click OK when done.
  

  



User Tasks
Splitting Design into Blocks
Creating Structural Systems

Connecting Structural Elements
Creating Physical Plates & Shapes

Design Assistant
Drawing Production

Managing Your Project
More About Catalog Slots, Endcuts & Small Assemblies

More About Openings
Structure Detail Design Package in Knowledge Expert 

 



Splitting Design into Blocks
Before starting the detail design per se, a build strategy is defined and a detail design block generated by 
applying a build strategy block to the functional design.

 

 

 

Build the block scheme: identify your block scheme, create a 3D grid dividing the ship into cells then 
define the basic block.

 
Generate detail design blocks: select the block to process and click OK.

Start detail design from scratch: build a block scheme then generate a detail design block.



Building the Block Scheme
This task shows you how to determine the basic block definition. To do so, you will prepare a 3D grid of 
cells representing the block scheme before actually defining the blocks themselves.

This is typically a planning task that lets you develop a build strategy that takes into account shipyard 
capabilities, standards and preferences.
1. Double-click to activate a first level entry in the specification tree at which to define the block scheme. 

If desired, you can create the block definition at the document root.
2. Click the Block Scheme  icon. 

The Block Scheme dialog box appears. 

3. Identify the block scheme, then click OK in the dialog box. 

The specification tree is updated with all appropriate features for the block scheme.

Preparing the Block Definition
4. Click the 3D Grid  icon to 

create a 3D grid that divides the 
ship into cells. 

The 3D Grid dialog box appears.



To make up the lists of planes, you can select: 
●     individual planes

●     entire plane systems by simply clicking one plane in the system

●     a combination of plane systems and individual planes
or,

●     surfaces.

The List  icon becomes active when you select more than one item. Click this icon to view the list 

of planes selected in the Elements list dialog box.

The Explode option in the dialog box lets you handle plane systems as individual planes.
5. Select a first set of planes or surfaces in one direction.
6. Click the Second list of planes field and select a second set of planes or surfaces in another direction.
7. Click the Third list of planes field and select a third set of planes or surfaces in the third direction.
8. Click Apply to preview the grid.

9. Using the List icon, make any necessary changes to the grid.  

You can remove or replace planes as well as add new planes to the list in the Elements list dialog box. 
Click Close when done. Then click Apply again in the 3D Grid dialog box to preview the results.

10.Click OK in the 3D Grid dialog box when satisfied to create the grid and visualize the scheme. 

A 3D grid is created.
Adjust grid transparency in the Properties dialog box.



You are now ready to define blocks from grid cells. 

Merging Grid Cells

Using the 3D Merge  command, you can merge grid cells. 

●     Select grid cells you want to merge.
Click the List icon to browse and modify the list of cells you want merged.



●     Click OK in the 3D Merge dialog box when done.

Defining Blocks
11.Click the Block  icon. 

The Block dialog box appears.

12.If necessary, select the block scheme entry in the specification tree.

The number of cells in the block scheme is identified in the List of block geometries field. Cells are 
highlighted in the geometry area.

You can visualize the list of cells by clicking the List  icon and remove any grid cells you do not 

want processed.
13.Click OK in the Block dialog box.

Basic blocks are defined as specified. 



You can now apply the block scheme to the functional design to define working units that will be used 
by the detail design engineer for structure detail design.

  



Generating Detail Design Blocks 
This task shows you how to apply a block scheme block to the functional design to define a working unit 
that will be used for structure detail design. 

This command handles individual blocks in the block scheme and is typically a design engineering task.
Have the block scheme and functional design open.

1. Click the Split by Block  icon.

The Split by Block dialog box appears.

2. Select the block you want to process. 

The system automatically detects all functional design items contained in this block that intersect the 
block definition. The number of items is listed in the Functional objects field. Items are highlighted in 
the geometry area.
This command manages functional plates and stiffeners, not functional systems.

3. Remove or add any functional design items to the list of objects to be processed as desired.
To visualize the list of functional items selected, click the List icon or right-click in the field and select  
Elements list from the contextual menu. You can remove or replace items as well as add new items in 
the Elements list dialog box.
The Split by Block command also lets you select items for special treatment, i.e. those items that you 
do not want trimmed to the block definition.

4. Click the No trimming field and select functional items that you do not want trimmed to the block 
definition. 

Notes: 

●     Multi-selection capabilities are available when selecting these items.

●     These items must be dealt with separately later.

5. Click OK when done to generate the detail design block. 

The detail design is generated under a single specification tree entry.



When generating the detail design, functional design classes are mapped to corresponding detail 
design classes as follows:

Plate system  -> Plating 
Stiffener system  -> Stiffening and beaming

  



Starting Detail Design from Scratch
This task shows you how to start your detail design from scratch, i.e. without any existing functional 
objects. 

Have defined a block scheme block.

When starting from scratch, do not open any functional design document.

1. Click the Split by Block  icon.

The Split by Block dialog box appears.

2. Select the block you want to process. 

A dialog box informs you that no functional objects intersect the block.

Note: If your functional design was open, remove all functional objects listed.
3. Click OK in the Warning dialog box, then in the Split by Block dialog box to generate an empty detail 

design block. 

The detail design is generated under a single specification tree entry.



You detail design block is ready; you can start your detail design for scratch.
If necessary, at a later date, you can return to the functional design and select objects of interest. 

●     Select the detail design block in the specification tree.

●     Click the Split by Block icon.

●     Select functional objects of interest.

●     Click OK.

  



Creating Structural Systems
Create a plating system: set parameters in the dialog box then select a support plane or surface, and if 
necessary define a contour. 
Create plating with free edge: set parameters in the dialog box, select a support plane or surface, and if 
necessary define a contour, then select the free edge. 
Create stiffening systems: select the paneling system to stiffen, set parameters in the dialog box then 
select web supports and define stiffening system limits.
Create stiffening on free edge: select a paneling system with a free edge, set parameters in the dialog 
box then define limits.
Create inserting systems: select a paneling system, set parameters in the dialog box then define a 
contour.
Create openings: select a stiffening or paneling system, specify the positioning strategy and inputs, then 
select a contour and a cutting mode.
Create beaming systems: activate a paneling system, set parameters in the dialog box, then define 
beaming limits, and two intersecting planes to define section direction and the beaming trace.

Miter: select the stiffening system to trim then the stiffening system serving as limit.

System split: select the paneling system to split, click the By field and select another paneling system, a 
surface or a plane.

Strake: select a plating system, click the 2D grid command and define a 2D grid.

Generate plates and shapes: make a multi-selection of detail design objects, click the Product node field 
and select the node where you want plates and shapes to be instantiated.



Creating Plating Systems 

This tasks shows you how to create plating systems.  

New plating systems are added where necessary to complete the functional design before starting the detailed 

design as such. 

A plating system is defined by a plane or surface (support) and a contour.

1.
Click the Plating  icon. 

The Plating dialog box opens.

2. Define the associated class: 
●     Click Change... opposite Object class:

The Class Browser opens and accesses the feature dictionary defining object classes. 

●     If necessary, expand the object class tree and select the desired class, e.g., Deck.

●     Click OK when done.

The selected class is displayed in the Object class field of the Plating dialog box.
3. Confirm or change plating system properties: 

●     Click the Design Table icon  and select a thickness from the design table, then click OK. 

●     Select a material and grade in the Material drop-down list.

Thickness and material-grade combinations are managed as project resources.



4. Select the support in your product. In our example, a plane. 

A support can be either a plane or a surface. 

As an alternative, with the Plating dialog box open, click Edit Contour... opposite the Support field, then select 
the support.

The Paneling Molded Surface dialog box will open and the support identity will appear in the Support field. 



Selecting Limits

●     Limits can be any combination of planes, surfaces or paneling systems. 

●     With respect to a paneling system, the application retrieves the molded surface and computes the 
intersection of the underlying molded surface with the support.

●     The order in which you select the limits is essential. Limits must be adjacent; for example, added in a 
clockwise or counterclockwise direction.

●     You can remove limits if necessary, but only in the reverse order in which they were set. 

5. Select the hull as the first limit. A blue curve will appear defining the limit.

6. Select one of the planes as second limit.  



If the curve extends in the wrong direction (as shown above) click either Other Side of First Limit or Other 
Side of Last Limit, to redirect the curves in the proper direction. 

●     Toggling the curve corresponding to the first limit can only be done via the dialog box.
Note: This option becomes unavailable when a third limit is selected.

●     Toggling the curve corresponding to the last limit can be done via the dialog box or by clicking the limit 
again in the geometry area.

7. Select the other planes in succession to close the contour. 

As you select the limits, click again to toggle the direction of each limit so that it points inwards so as to close 
the contour.



Color Coding

●     As you select the limits for your contour the curves are blue. When the contour has been closed properly 
the contour highlights green. This, however, does not prevent you selecting other limits to define plating 
of a more complex shape.

●     A dotted blue curve corresponds to the current limit. 

●     A red curve means that the current limit does not intersect the previous limit.

8. Click OK when satisfied to return to the Plating dialog box.

A vector in the geometry area shows the direction in which plating system thickness will be oriented. By 
default, the orientation of plating thickness is defined according to molded conventions. Molded conventions 
are managed as project resources.

9. Set the offset position of the plating system with respect to the support: 

Enter an offset value in the Offset field or click Center to center the plating system with respect to the 
support. The offset value may be no greater than the plating thickness.



Offset

●     Offset is calculated in the direction opposite that of the material throw orientation.

●     Centering the plating system positions it at half the material thickness.

 
Support top view

This option is only available if the support is a plane and is shared by both Plating and Paneling Molded 
Surface dialog boxes. When checked, the document view is that of the support plane. 

10.(Optional) Change the orientation of plating system thickness by clicking the vector in the geometry area or 
checking the Reverse direction option in the Plating dialog box. 

 11.(Optional) Click Preview to visualize the result. 
12.Click OK to generate the new plating system. 

Editing Plating

You can edit the definition of plating to change plating:

●     Thickness

●     Material

●     Support (via the Edit Contour... command, then click the Support field and select a new support).

To do so, right-click the plating in the specification tree and select Definition from the contextual menu.





Creating Plating with Free Edge 

This tasks shows you how to create plating with a free edge.  

New plating systems are added where necessary to complete the functional design before starting the 

detailed design as such. 

A plating system is defined by a plane or surface (support) and a contour with a free edge.

1. Click the Plating with Free Edge  icon. 

The Plating with Free Edge dialog box opens.

2. Define the associated class: 
●     Click Change... opposite Object class:

The Class Browser opens and accesses the feature dictionary defining object classes. 

●     If necessary, expand the object class tree and select the desired class, e.g., Deck.

●     Click OK when done.

The selected class is displayed in the Object class field of the Plating with Free Edge dialog box.



3. Confirm or change plating system properties: 

●     Click the Design Table icon  and select a thickness from the design table, then click OK. 

●     Select a material and grade in the Material drop-down list.

Thickness and material-grade combinations are managed as project resources.
4. Select the support in your product. In our example, a plane. 

A support can be either a plane or a surface. 

As an alternative, with the Plating dialog box open, click Edit Contour... opposite the Support field, 
then select the support.

The Paneling Molded Surface dialog box will open and the support identity will appear in the 
Support field. 



Selecting Limits

●     Limits can be any combination of planes, surfaces or paneling systems. 

●     With respect to a paneling system, the application retrieves the molded surface and computes 
the intersection of the underlying molded surface with the support.

●     The order in which you select the limits is essential. Limits must be adjacent; for example, 
added in a clockwise or counterclockwise direction.

●     You can remove limits if necessary, but only in the reverse order in which they were set. 

5. Select a plane as the first limit. A blue curve will appear defining the limit.



6. Select the hull as second limit. 
If the curve extends in the wrong direction (as shown above) click either Other Side of First Limit or 
Other Side of Last Limit, to redirect the curves in the proper direction. 



●     Toggling the curve corresponding to the first limit can only be done via the dialog box.
Note: This option becomes unavailable when a third limit is selected.

●     Toggling the curve corresponding to the last limit can be done via the dialog box or by clicking 
the limit again in the geometry area.

7. Select other planes in succession to close the contour. 

As you select the limits, click again to toggle the direction of each limit so that it points inwards so 
as to close the contour.

Color Coding

●     As you select the limits for your contour the curves are blue. When the contour has been closed 
properly the contour highlights green. This, however, does not prevent you selecting other 
limits to define plating of a more complex shape.

●     A dotted blue curve corresponds to the current limit. 

●     A red curve means that the current limit does not intersect the previous limit.

8. Click the Free edge field, then select the free edge. 

The free edge is a curve and must exist in the document. It is always selected last.



9. Click OK when satisfied to return to the Plating with Free Edge dialog box.

A vector in the geometry area shows the direction in which plating system thickness will be 
oriented. By default, the orientation of plating thickness is defined according to molded 
conventions. Molded conventions are managed as project resources.



10. Set the offset position of the plating system with respect to the support: 

Enter an offset value in the Offset field or click Center to center the plating system with respect to 
the support. The offset value may be no greater than the plating thickness.
Offset

●     Offset is calculated in the direction opposite that of the material throw orientation.

●     Centering the plating system positions it at half the material thickness.

 
Support top view

This option is only available if the support is a plane and is shared by both Plating and Paneling 
Molded Surface dialog boxes. When checked, the document view is that of the support plane. 



11. (Optional) Change the orientation of plating system thickness by clicking the vector in the geometry 
area or checking the Reverse direction option in the Plating with Free Edge dialog box. 

 12. (Optional) Click Preview to visualize the result. 
13. Click OK to generate the new plating with free edge. 

Editing Plating with Free Edge

You can edit the definition of plating with free edge to change plating:

●     Thickness

●     Material

●     Support (via the Edit Contour... command, then click the Support field and select a new 
support)

●     Free edge (via the Edit Contour... command, then click Undo Last Limit and select the new free 
edge).

To do so, right-click the plating in the specification tree and select Definition from the contextual 
menu.



Creating Stiffening Systems 
This task shows you how to stiffen plating. 

Stiffening systems are added to plating under paneling systems where necessary to complete the 
functional design before starting the detail design as such.

A stiffening system is defined by a web support (a plane or surface) and two limits (also planes). You can 
create all kinds of stiffenings, including twisted stiffenings along the hull, using this command.
1. Select the paneling system you want to stiffen in the specification tree or in the geometry area, then 

click the Stiffening  icon, 

Or,

Click the Stiffening  icon, then select the paneling system you want to stiffen.

Note: The system detects the paneling if you select a constituent part in the geometry area. 

The Stiffening dialog box appears.



2. Define the associated class:  
●     Click Change... opposite Object class

The Class Browser opens and accesses the feature dictionary defining object classes. 

●     Expand the object class tree and select the desired class

●     Click OK when done.

You can now specify stiffening system properties.
3. In the Section field, select the section shape and size you want to use. Click: 

●     One of the available section names, or

●     Other section... to access catalog sections not already listed. A sample section catalog is supplied 
with the product.

The path to the folder containing the list of available sections and the section catalog are managed as 
project resources.
If there are no choices in the Section field, click Other section... and initialize a section list with 
catalog sections for subsequent use.

The Catalog Browser opens letting you browse and preview the contents of the current catalog, by 
default the AISC_BigScale catalog. You have several choices of standard section types.

●     Browse available categories in the Catalog Browser dialog box and double-click the category of 
interest

●     Browse the list of shape sizes and select the size of interest



 If you get the following message: 

The source file of the design table AISC_XX wasnt found. The design table is in broken state 
while this file isn't found.

the design table path is not updating properly to reflect the catalog location. For information on how 
to correct this, see About Section Catalogs.

●     Click OK in the dialog box

For information on options in the Catalog Browser, see Using Catalogs in the Infrastructure User's 
Guide.

●     Repeat until you have selected all catalog sections you are likely to need.

As sections are created in your document, copies of the sections are added to a resolved directory. 
This resolved sections directory (or folder) is the source for the list of available sections when you 
click the drop-down arrow opposite Section in the Stiffening dialog box.

The path for this resolved directory is managed in transparent fashion for the user, but can be 
customized by the administrator as a project resource.

4. Select a material and grade in the Material drop-down list. 

Material-grade combinations are managed as a project resource.

You are now ready to position the stiffening system.
5. In the preview or in the Anchor point list, select the point at which to anchor the section to the 

plating:

By default, the stiffening section is positioned normal to the plating.
Right-click in the Anchor point field to limit 
the anchor points listed to user-defined 
anchor points.

  Three user-defined anchor points (WebSideRight, WebSideLeft and WebCenter) for L, T and bulb 

sections are supplied with the product. These anchor points are accompanied by the symbol  to 

distinguish them from standard anchor points ( ).
6. If needed, specify an angle to orient the section around its anchor point. 

By default, the orientation field is updated in 90 degree increments. You can change the rotation 
increment:

●     Right-click in the field

●     Select Change step, then 1 degree or new one and set the step value you want to use. 



In the illustration below, the section is anchored WebSideRight at 0 degrees (left-hand section) and at 
15 degrees (right-hand section).

7. Click the Web support field and select the web support.

The web support is a plane or surface. The section is oriented in the same plane as the web support 
and is swept along the intersection curve between the plane and the molded surface of the parent 
paneling system. Plating thicknesses are taken into account.

Note: Multiple selection is available for the web support.

You can, if desired, enter an offset with respect to the web support.
8. If necessary, check the Normal to molded surface option.

The section is oriented normal to the molded surface of the paneling system as it is swept along the 
trace curve. 
Check this option to stiffen the hull and create twisted stiffening systems.

9. Click the First limit field and select a first plane.
10.Click the Second limit field and select a second plane.
11.Click Preview to visualize the stiffening system.

By default, stiffening systems are placed according to molded conventions and are placed on the 
opposite side of the default orientation for plating thickness. Molded conventions are managed as 
project resources.



12. If needed, click Change Side to place the stiffening system on the opposite side of the plating, then 
click Preview to view the result.



13. If needed, click Change Orientation to flip the stiffener section around its anchor point, then click 
Preview to view the result.

You can make changes to stiffening system position (anchor point, orientation, etc.) at any time and 
click Preview to see the result.

14.Click OK when done.

Editing Stiffening

You can edit the definition of stiffening to change both the properties and position of the stiffening.

To do so, right-click the stiffening in the specification tree and select Definition from the contextual 
menu.

Note: If needed, select Compute when changes have been made to take plating thickness into 
account.

  



Creating Stiffening on Free Edge 
This task shows you how to add constant-section (flat bar) stiffening systems to free edges of plating or around openings 
in order to stiffen edges and prevent water washing through doors and other openings.

   
1. Select a paneling system with free edge or with openings in the specification tree or the geometry area, then click the 

Stiffening on Free Edge  icon, 

Or,

Click the Stiffening on Free Edge  icon, then select a paneling system.

Note: The system detects the paneling if you select a constituent part in the geometry area.

The Stiffening On Free Edge dialog box appears.

The selected paneling is identified in the Free edge field. 



2. Define the associated class:  
●     Click Change... opposite Object class

The Class Browser opens and accesses the feature dictionary defining object classes. 

●     Expand the object class tree and select the desired class

●     Click OK when done.

You can now specify stiffening system properties.
3. In the Section field, select the section shape and size you want to use. For stiffening with free edge, you will want a 

flat bar. 

Click:

●     One of the available section names, or

●     Other section... to access catalog sections not already listed. A sample section catalog is supplied with the 
product.

The path to the folder containing the list of available sections and the section catalog are managed as project 
resources.
If there are no choices in the Section field, click Other section... and initialize a section list with catalog flat bar 
sections for subsequent use. 

The Catalog Browser opens letting you browse and preview the contents of the current catalog, by default the 
AISC_BigScale catalog.

●     Browse available categories in the Catalog Browser dialog box and double-click Flat_Bars

●     Browse the list of shape sizes and select the size of interest



 If you get the following message: 

The source file of the design table AISC_XX wasnt found. The design table is in broken state while this file 
isn't found.

the design table path is not updating properly to reflect the catalog location. For information on how to correct this, 
see About Section Catalogs.

●     Click OK in the dialog box

For information on options in the Catalog Browser, see Using Catalogs in the Infrastructure User's Guide.

●     Repeat until you have selected all flat bar sections you are likely to need.

All selected flat bar sections are added to the folder containing available sections.

As flat bar sections are created in your document, copies of the sections are added to a resolved directory. In 
addition, this resolved sections directory (or folder) is the source for the list of available sections when you click the 
drop-down arrow opposite Section in the Stiffening on Free Edge dialog box.

The path for this resolved directory is managed in transparent fashion for the user, and can be customized by the 
administrator as a project resource.

4. Select a material and grade in the Material drop-down list. 

Material-grade combinations are managed as a project resource.

You are now ready to position the stiffening system.
5. In the preview or in the Anchor point list, select the point at which to anchor the section along the free edge. 

By default, the stiffening system section is positioned normal to the free edge.



Right-click in the Anchor point field to limit the anchor 
points listed to those most suited to your purposes. Three 
lists are proposed: Standard, User and Standard+User.

  Three user-defined anchor points (WebSideRight, WebSideLeft and WebCenter) for L, T and bulb sections are 

supplied with the product. These anchor points are accompanied by the symbol  to distinguish them from 

standard anchor points ( ).
6. If needed, specify an angle to orient the section around its anchor point. 

By default, the orientation field is updated in 90 degree increments. You can change the rotation increment:

●     Right-click in the field

●     Select Change step, then 1 degree or new one and set the step value you want to use. 

7. If it is not the free edge of the activated paneling that you want to stiffen but an opening, click the Free edge field 
and select an opening on the same paneling in the specification tree. 

In the case of a paneling with free edge, the system detects the free edge.

You can also enter an offset with respect to the plating.
8. If desired, define limits for the free edge of a paneling: 

●     Click the First limit field and select a first plane.

●     Click the Second limit field and select a second plane.

Note: You cannot define limits for coamings.
9. Click Preview to visualize the stiffening system.

10. If needed, click Change Side to place the stiffening system on the opposite side of the paneling, then click Preview to 
view the result.



 

11. If needed, click Change Orientation to flip the stiffener section around its anchor point, then click Preview to view the 
result.
You can make changes to stiffening position (anchor point, orientation, etc.) at any time and click Preview to see the 
result.

12. Update if necessary to take plating thickness into account.
13. Click OK when done.

  



Creating Inserting Systems 

This tasks shows you how to create inserting systems.  

Inserting systems are a special type of plating that, typically, are used locally to reinforce certain areas. They are 

created under paneling systems

1.Select the paneling system to which you want to add an inserting in the specification tree, then click the Inserting 

 icon, 

Or,

Click the Inserting  icon, then select the paneling system in the specification tree.

The Inserting panel appears. The Support field identifies the molded surface of the paneling. This is the surface used 
as sketch support.

3.Define the associated object class: 
●     Click Change... opposite Object class.

The Class Browser opens and accesses the feature dictionary defining object classes. 

●     If necesssary, expand the object class tree and select the desired class.

●     Click OK when done.

The selected class is displayed in the Object class field of the Inserting dialog box.



4.Define a contour for your inserting system: 

●     Click the Sketcher  icon to enter the Sketcher workbench and sketch your contour, then exit the Sketcher 

when done.
Or,

●     Select an existing contour.

5.Click the thickness design table icon and select a thickness from the Design Table dialog box that appears, then click 
OK. 

Thickness is managed via a design table. This table is a project resource.
6.Select a material-grade combination from the drop-down list. 

Material-grade combinations are managed as a project resource.
7.Position the inserting system with respect to the support: 

●     Enter an offset in the Offset field,
or,

●     Click Center to center the inserting system with respect to the support, i.e. the molded surface of the paneling.

Offset is measured in the direction opposite that of the throw orientation. A positive or negative offset can be 
entered of a value no greater than the thickness of the inserting system.

 
●     If necessary, check Reverse direction to change the throw orientation.

Viewing the Inserting System

●     Check 2D view to obtain a 2D view

●     Click Preview to visualize the result

8.Click OK to generate the new inserting system.

The inserting system strengthens locally and impacts all plating systems in the paneling system. 





Creating Openings 

This task explains how to create openings.  

1. Click the Opening  icon, then select the system in the specifications tree for which the opening is to be 

applied. This can be a stiffening system or a paneling system.

The Opening dialog box appears.

2. Define the associated object class: 
●     Click Change... opposite Functional system.

The Class Browser opens and accesses the feature dictionary defining object classes. 

●     If necessary, click the Expand Tree button and select the desired class.

●     Click OK when done.

The selected class is displayed in the Functional system field of the Opening dialog box.   
3. Specify the positioning strategy: 

Click the Strategy drop-down arrow in the position area and select the strategy of interest.

 



Positioning Strategies

Openings are located using user features which offer a choice of strategies letting you precisely define the 
location. The following types are available:

  Middle Two edges
  

  Two planes Mid-distance
  

  Double mid-distance  
   

  Half-height (one plane) Half-height (two planes)



  

  The support plane is the molded surface and is automatically identified in the Middle, Two edges and Two planes 
strategies if the molded surface is a planar surface.

4. Click Create... The Insert Object dialog box opens and displays the inputs and selections.  



The support plane is identified in the geometry area.

The Reference field of the dialog box displays the selected strategy. If you wish to name the opening, enter the 
name in the Name field.

5. Select the inputs to define the positioning, then click Preview to view results.
  

 6. Click Parameters to modify offset and angle values if 
necessary. 

The Parameters dialog box appears.

Use preview in the Insert Object dialog box to view the 
result.

 7. Click OK when done.

You return to the Opening dialog box.



8. Check the Support top view option in the Opening dialog box to get a top view of the 3D model. 

 9. Use the green manipulators to adjust the position of the opening. 

Manipulators are centered at the intersection of reference planes. Using them you can move the opening at a 
predefined step in one of two directions (longer arrows), or in both directions together (smaller set of arrows) 
depending on the manipulator selected.

The Offset step in the Opening dialog box defines the increment used. If, for example, you enter 100mm in this 
field, as you move the manipulators, the offset will increment in steps of 100mm.

You can also edit the position of the opening via the Edit... option in the Opening dialog box. Clicking this option 
opens a Definition dialog box. Offset values are set in the Parameters tab.

Note: The Inputs tab of this dialog box lets you change opening inputs.
10.Specify the contour type: 

You can select a contour from a catalog, sketch the contour or import it. 



Catalog Contour

●     Click the catalog icon in the contour area:

The Catalog Selection dialog box appears.

●     Navigate in the dialog box to select the shape, then click OK.

Sketched Contour

●     Click the Sketcher icon, draw your shape in the Sketcher workbench, then exit.

The name of the sketch is displayed in the Shape field.



Imported Contour

●     Select an existing contour in another part
Or,

●     Create the contour in the opening part. 
In this case, you must first create an empty opening. Set the Contour Type to Imported and click OK. Create 
the contour in the dedicated contour openbody of the opening, then edit the opening and select the contour.
Note: You cannot define a positioning strategy for this contour type.

The selected contour is identified in the Shape field.
11.In the Opening dialog box, click Preview to view the proposed opening. 
12.Select the Cutting mode.

Cutting Mode

Two modes are available:

●     Before forming: the opening (in yellow) will be created normal to the support surface.

●     After forming: the opening (in yellow) will be created normal to the plane containing the contour.

13.Click OK in the Opening dialog box when satisfied. 

The opening is created.



  
Managing Openings

You can:

●     Edit the definition of openings to change the position, contour and cutting mode (Definition).

●     Delete openings including any features created by the opening (Remove).

●     Update after changes, for example, to take into account stiffeners added after the openings themselves were 
created (Compute).

  To do so, right-click the stiffening in the specification 
tree and select the appropriate command from the 
contextual menu.



Creating Beaming Systems 

This tasks shows you how to create a beaming system.  

New beaming systems are added where necessary to complete the functional design before starting the 

detailed design as such. They are created under paneling systems. 

A beaming system is defined by two intersecting planes and two limits.

As sections are created in your document, copies of the sections are added to a resolved directory. In 
addition, this resolved sections directory (or folder) is the source for the list of available sections when 
you click the drop-down arrow opposite Section in the Beaming dialog box.

The path for this resolved directory is managed as a project resource, however, there is no default path 
for this resource. This path must be correctly set in order for the Beaming command to work properly. 
Normally, it is the administrator's task to do so. Please contact your administrator if the path has not been 
set properly.
1. In the specification tree, double-click the paneling system under which you want to create your 

beaming system.

2. Click the Beaming  icon. 

The Beaming dialog box appears.



3. Define the associated object class: 
●     Click Change... opposite Object class

The Class Browser opens and accesses the feature dictionary defining object classes. 

●     Expand the object class tree and select the desired class.

●     Click OK when done.

4. In the Section field, select the section you want to use. Click: 
●     One of the available section names, or

●     If no choices are available, click Other section... to access catalog sections. A sample section 
catalog is supplied with the product.

The path to the folder containing the list of available sections and the section catalog are managed 
as project resources.
If there are no choices in the Section field, click Other section... and initialize a section list with 
catalog  for subsequent use. 

The Catalog Browser opens letting you browse and preview the contents of the current catalog,  by 
default the AISC_BigScale catalog. You have several choices of standard section types.

●     Browse available categories in the Catalog Browser dialog box and double-click the category of 
interest.

●     Browse the list of shape sizes and select the size of interest.

●     Click OK in the dialog box

For more information on options in the Catalog Browser, see Using Catalogs in the Infrastructure 
User's Guide.

●     Repeat until you have selected all catalog sections you are likely to need.

All selected sections are added to the folder containing available sections.
 If you get the following message: 

The source file of the design table AISC_XX wasnt found. The design table is in broken 
state while this file isn't found.

the design table path is not updating properly to reflect the catalog location. For information on 
how to correct this, see About Section Catalogs.

5. Select a material and grade in the Material drop-down list. 

Material-grade combinations are managed as a project resource.



6. Define the anchor point used to place the beaming: 
●     Select the anchor point from the drop-down list,

or,

●     Click a green dot in the preview to change the anchor point (red when selected).

Right-click in the Anchor point field and select Standard from the contextual menu to display only 
standard anchor points in the list.

Standard anchor points are accompanied by the symbol to distinguish them from user anchor 

points ( ).
7. Use the Orientation arrows to rotate the section around its anchor point.

The Orientation field is updated in 90 degree increments by default. You can change the rotation 
increment. Right-click in the Orientation field  and select Change step from the contextual menu. 
Select 1deg or select new one and set the step value you want to use.

8. Define beaming limits: 
●     Select a first limit.

●     Select a second limit.

Limits can be planes or surfaces.
9. Select a first plane to define the direction of the beaming section (Section direction). 

This plane defines the direction of the local U-axis of the section.
10. Click Section orientation field and select a second plane to 

define the beaming trace.  

The beaming trace is defined by the intersection of the two 
selected planes.

You can change the section, material, anchor point and 
orientation while in the preview mode.

Multi-selection in Section direction & Section orientation Fields

Multi-selection is available for Section direction and Section orientation fields. If more than one set 
of planes is defined, beams are created at the intersections of all defined planes.

Click the List  icon to view selected planes in the Elements List dialog box.



Flip U & Flip V

●     Click on Flip U to orient the local U-axis in the opposite direction. 

●     Click on Flip V to orient the local V-axis in the opposite direction. 

11. Click OK when done. 

The beaming system is created between specified limits at the intersection of selected planes.



Mitering 

This task shows how to make a miter cut between stiffening systems. 

Mitering defines an angle joint between two stiffening systems. The cutting plane is defined at the 
intersection of the two center axes of the two systems.

No sample document is provided.

 

 

1. Click the Mitering  icon.

The Mitering dialog box appears.

By default, the Type list is set to Miter cut.

Note: The None option lets you remove a 
previously applied miter cut.

2. In the Offset box, use the arrows to change the offset value or enter a value directly in the box 
to offset the cutting plane.

3. Select the stiffening system you want to trim (Member to trim).

4. Select the stiffening system serving as limit  (Trimming member).

5. Click OK to create the cut.

Stiffening systems are cut as specified in the dialog box and the miter cut is identified in the 
specification tree.



System Split 

This command lets you split systems by other systems, planes and surfaces and is particularly useful 
where systems intersect to identify which system is intercostal and which one is continuous. You can 
also use this command to create points on-the-fly to split coamings.

System split is typically done at the start of detail design when major structural systems have been 
created but before any detail parts or features are built.

Typical scenarios are:

●     Paneling, plating, stiffening or inserting (intercostal system) is split by paneling (continuous 
system).

●     Stiffening (intercostal system) is split by stiffening (continuous system).

●     Paneling, plating, stiffening or inserting is split by a plane or surface.

●     Coaming split by two points.

Multiple selection is available in this command.

This task shows how to split a paneling system by another paneling system.

No sample document is provided.

 

 

1. Click the System Split  icon.

The System Split dialog box 
appears.

You can also select the paneling 
system you want to split before 
you click the command. 



2. In the geometry area or 
specification tree, select the 
paneling system you want to split. 
In our example, a bulkhead 
paneling system with constituent 
stiffening systems.

 

Paneling Checkbox

By default the Paneling option is active. This means that if you select a plating, stiffening or 
inserting, the system takes into account the associated paneling system (including all constituent 
systems).

To select a plating, stiffening or inserting (rather than the entire paneling system), uncheck the 
Paneling option first, then select systems in the geometry area or specification tree. 

You can view your selection in a separate dialog box by clicking the list  icon or right-clicking 

the field and selecting Elements list from the contextual menu.

3. Click the By field, then select another paneling system. In our example, the deck. 

Note: If you select plating or inserting, then the system takes the associated paneling into account.

 

Split By

You can also select a surface or a plane and split the system with this element.  

4. Click OK to split the paneling system.

All systems in the bulkhead paneling system are split in two by the molded form of the second 
system (in our case, the deck) and the specification tree updated accordingly.



 

Intercostal Split of Stiffening Systems

You can also split intersecting stiffening systems that lie on the same paneling system. 

●     Uncheck the Paneling option.

●     Identify which stiffening systems are intercostal and which ones are continuous.

Intercostal systems are split at the web support of the continuous stiffening system.



Coaming Split by Two Points
This task shows how to split a coaming by creating two points on-the-fly.

Note: Coamings are split one at a time.

No sample document is provided.

 

 

1. Click the System Split  icon.

The System Split dialog box appears.

 2. Click to clear the Paneling 
checkbox.

The Split Point icon appears in the 
dialog box.

 3. Select a coaming.

The coaming is highlighted in the document.

 4. Click the By field.

The Split Point icon becomes active.



 5. Click the Split Point icon.

The Split Point dialog box appears. 

  The trace curve, an endpoint located on this curve and a direction arrow are shown in the geometry 
area. 

The endpoint is the reference point with respect to which your split point will be created.

●     If no point exists, an endpoint is created and displayed.

●     If a split point already exists, this point is taken as the reference point.

Click Reverse Direction to compute the distance or ratio in the opposite direction.

  

 6. Do you want to create a split point at a certain distance from the reference point?
●     If yes, enter a value in mm in the Distance on curve field.

●     If no, select the Ratio of curve length option and enter a ratio in the ratio field.

 You can also move your cursor along the curve trace to desired location in either mode, then click 
and see the distance or ratio value display in the dialog box.



  

 7. Click OK to create the split point.

You return to the System Split 
dialog box, but you still need a 
second point to split the coaming.

 8. Click the Split Point icon again and 
create a second split point.

Note: The first split point is taken 
as the reference point.

 Important: The two split points must not lie on the same straight segment of the coaming. They 
must be created such that a virtual line cutting the contour of the coaming at the two selected 
points can be drawn.
Correct: Incorrect: the coaming cannot be split.

9. Click OK in the System Split dialog box when done.



How Features are Managed

Original Shape

 
After Split; Absolute Positioning of Features (cutouts)

 
After Split; Relative Positioning of Features (cutouts)



Straking 
The Straking command lets you prepare plating or paneling systems for manufacturing. This can be done 
using:

●     Wireframe elements
This method is particularly useful for paneling systems and non-planar plating systems. You can also 
strake planar plating systems.

●     A 2D grid.
You can only strake planar plating systems using this method.

You can edit or delete an existing straking strategy whether created via wireframe elements or a 2D grid.

Straking using 2D Grid
This task shows you how to strake planar plating using a 2D grid.

You cannot strake paneling systems or non-planar plating systems using this method.
No sample document provided.

1. Click the Straking  icon then select the planar 

plating you want to strake 

Or,

Select the planar plating you want to strake, then 
click the Straking icon.

  The Straking dialog box identifies the plating and 
the 2D Grid tab is active. 

Note: A planar plating system can be straked 
using either method: Wireframe or 2D Grid.

On detection of a planar plating, the Straking dialog box automatically opens showing the 2D Grid 
tab. If, however, you then select a wireframe element, the dialog box automatically moves to the 
Wireframe tab.

If a straking strategy has already been associated to the selected plating, the dialog box opens at 
the appropriate tab and you can modify it, or delete it and start again.

●     To modify a 2D grid, click the 2D Grid command 

●     To delete a 2D grid, click the Delete command.



2. Click the 2D Grid  command in the 2D Grid tab. 

The 2D Grid dialog box opens. The plating surface is taken as the grid support.  

Spacing is the default mode for defining your grid.

A bounding box is computed around the support. 

A 2D axis system and grid anchor points are also 
visible in the geometry area. 

By default the grid horizontal axis is oriented in 
the same direction as the horizontal axis of the 
selected support.

3. Select Spacing or Number in the Define with list box to set the grid construction mode. 
●     In Spacing mode, you will specify the distance between grid lines along horizontal and vertical 

directions.

●     In Number mode, you will specify the number of cells in horizontal and vertical directions.

Both distance and number of cells are computed with respect to the bounding box.

This task is done using the default mode.



4. Specify the distance between grid lines in 
horizontal and vertical spacing fields, then click 
Apply. 

The system computes and displays the grid.

Note: An extra row and an extra column of cells 
is always added.

Right-click in Horizontal or Vertical spacing fields and change the step at which the box increments.

5. If necessary, select a direction. 

The horizontal grid axis is oriented in the same direction as the selected direction.

Checking Implicit direction re-orients the horizontal grid axis back along the horizontal axis of the 
selected support.



6. Define the grid origin: select the origin from the drop-down list, for example Bottom right.

7. If desired, enter a negative horizontal and or vertical offset to offset the grid from its origin. 

Note: You cannot enter a value greater than the corresponding spacing value.

8. Check Swap horizontal/vertical to swap horizontal and vertical spacing.



9. Click the Sketcher icon to tweak the shape of grid cells. 

The Sketcher workbench opens.

●     Click and drag one of the points on the grid to adjust cell shape as desired.

●     Repeat if necessary.

●     Exit the Sketcher when done.

10. Adjust grid parameters until satisfied.
11. Click OK in the 2D Grid dialog box when done. 

A progress bar is displayed letting you monitor the operation.

The grid is created under the active part of the selected plating.

Use the 2D Merge command in the 2D Grid tab to combine two or more cells into one.



12. Click OK when done in the Straking dialog box.

Straking using Wireframe Elements
This task shows you how to strake shell plating using wireframe elements.

The wireframe method is particularly useful for paneling systems and non-planar plating systems. You 
can also strake planar plating systems.
No sample document provided.

1. Click the Straking  icon then select the 

plating you want to strake 

Or,

Select the plating you want to strake, then click 
the Straking icon.

  The Straking dialog box identifies the shell plating 
and the Wireframe tab is active. 

If a straking strategy has already been associated to the selected plating, the dialog box opens at 
the appropriate tab and you can modify it, or delete it and start again.

●     To modify wireframe elements taken into account, click the List  command.

●     To delete wireframe elements, click the Delete command.

2. Select wireframe elements.

You can select surfaces, planes and curves intersecting the support of the plating or paneling 
system. The number of elements selected is listed in the Elements field.

 3. Click Show intersections to visualize intersection curves.

Blue curves represent the intersections between selected wireframe elements and the shell plating 
support. 



  

 4. If necessary, adjust the result using the List command opposite Elements.

The Elements list dialog box opens letting you replace or remove selected wireframe elements.
5. Click OK when done in the Straking dialog box.

  



Merging 
The 2D Merge command lets you combine two or more existing 2D grid cells to make a larger cell.

This task shows you how to merge grid cells.

Have created a 2D grid.

1. Click the 2D Merge command in the Straking dialog box. 

The 2D Merge dialog box appears. 

2. Select grid cells you want to merge in the specification tree or in the geometry area.
Right-click in field and select Elements list from the contextual menu to browse and change list of 
cells to merge.

3. Click OK when done.

Merged cells are placed in No Show in the specification tree and a new entry is created for the new 
cell.



  



Generating Plates & Shapes 

Generating shapes and plates is the last step in detailed design that marks that start of the 
manufacturing process. This command initiates a manufacturing view of your ship containing all the 
information needed for manufacturing that was included at the detail design stage. 

Generating shapes and plates is done in two steps:

●     Straking plating: this preparatory step can be performed during detail design whenever plating is 
ready.

●     Generating plates and shapes: this step is typically performed when the detail design is finished.

This task shows you how to initiate your manufacturing view.

Have straked your plating systems and completed the detail design.

 

1. Click the Generating Plates & Shapes  icon. 

The Generating Plates & Shapes dialog box appears.

2. Make a multi-selection of detail design objects that you want to see in the manufacturing view.

Objects can be plating, stiffening, beaming, plates, shapes, and/or assembly templates. You can 
also select entire blocks or paneling systems and all constituent plating, stiffening, beaming, 
plates and shapes are taken into account.

 

Click the List  icon to view selected items in the Elements List dialog box.

3. Click the Product node field when done, then select the node in the specification tree where you 
want plates and shapes to be instantiated.

 

You can generate shapes and plates in: 
●     A new document

●     An existing node of your document

●     A new node of your document (insert a product).

4. Click OK when done. 

Plates and shapes are generated under the selected tree node.



Connecting Structural Elements
Automatically connect structural elements: select a system, identify the impact then set other parameters 
in the dialog box.
Manually connect structural elements: select structural elements to connect in a single connection, 
identify the impact then set other parameters in the dialog box.
Refine or modify connections: select a structural connection then select geometrical elements of plates or 
stiffeners to refine your connection.

 

Provided you have the appropriate license, the Weld Design product can be used to create welded joints 
between physical plates and shapes.



Automatically Connecting Structural Elements 
Establishing connectivity between structural elements is important. Many different types of connectivity 
may be found in a ship. These include plate to plate connections, plate to stiffener connections, stiffener 
to stiffener connections.

This connectivity captures the functional requirements and will be physically implemented downstream by 
means of joints and added piece parts (chocks, transitions, brackets, etc.).
This task shows you how to automatically connect all structural plates within a plating system.

You can also specify connectivity between two systems, for example between all stiffeners in a deck 
stiffening system and the deck itself (a plating system).
Have created a plating system with appropriate plates.

1. Click the Automatic Connection  icon: 

The Automatic Connection dialog box appears.



2. In the geometry area or in the specification 
tree, select the plating system. 

The system detects all plates in the plating 
system.

To specify connectivity between two systems, select systems of interest. 

Systems can be stiffening, plating or beaming systems.
3. In the impact column, right-click the plating 

system and identify the impact on this 
system by selecting it in the contextual 
menu displayed.  

Four impacts are available:

●     None: the connection has no impact on 
the system.

●     Interrupted: the connection requires that 
the system be split into one or more sub-
systems.

●     Minor: the connection requires the 
addition of a feature, such as cutback, 
slot, endcut, bevel.

●     Minor + Interrupted

Note: If two systems are selected, the 
impact on each system may be different.

Impacts

Impacts are managed in a customizable CATNls file, CATStrImpactConnectionCode.CATNls. 
This lets you add other impacts or rename existing ones. 

The default location of this file is: downloaddirectory/OS/intel_a/resources/msgcatalog 
where OS is the operating system, for example intel_a (Windows).

Impacts can then be used as keywords in detail connection catalogs, letting the designer query for 
detail connections satisfying certain impact criteria when physically implementing functional 
connections.



4. Click the Catalog  icon opposite the Of type field and select a catalog connection or enter a 

comment directly in the Of type field.
Catalog Connections

A sample catalog of different connection types is provided with the product.

●     Click the catalog icon.
The Catalog Browser opens letting you browse and preview the contents of the current catalog.

●     Browse the families and double-click the family of interest.

●     Browse the list of connections and select the one of interest.

●     Click OK in the Catalog Browser.

For information on options in the Catalog Browser, see Using Catalogs in the Infrastructure User's 
Guide.

5. Set the efficiency, for example 75%.

The efficiency lets you assess the resistance of the connection.

Efficiency

Efficiency is managed in a customizable CATNls file, CATStrEfficiencyConnectionCode.CATNls. 
This lets you add other values or rename existing ones. 

The default location of this file is: downloaddirectory/OS/intel_a/resources/msgcatalog 
where OS is the operating system, for example intel_a (Windows).

Efficiency can then be used as a keyword in detail connection catalogs, letting the designer query 
for detail connections satisfying certain efficiency criteria when physically implementing functional 
connections.

6. Check With added piece parts if you know that the physical connection detail will require the 
addition of features (cutback, slot, etc.).

7. Click Preview to visualize functional 
connections in the geometry area.

8. Click OK when done to create the connection. 

The system automatically establishes the connectivity between all plates in the plating system.



Connections are added to the specification tree (one entry for each connection established). They 
are grouped under an Assembly Joints entry.

When connections are made within a plating system, between two plating systems or between a 
plating system and a stiffening system, a joint body is also created for each connection to identify 
the published faces at which the connection is established.

●     A yellow symbol containing an exclamation mark in the specification tree means that the 
connections would be more judiciously placed elsewhere in the tree.
For example, if connections are within a plating system, it is best to activate the plating system 
and create the connections under the plating system; if between a plating system and a 
stiffening system, it is best to activate the common tree entry just above these systems and 
create connections there.

●     To edit the structural connection, double-click the appropriate Joint Structural View entry in the 
specification tree.

Typical Examples of Connectivity between Systems
A. None (stiffener) / Minor - addition of a slot (bulkhead)

 



B. None (yellow stiffener) / Interrupted (red stiffener)

C. None (deck) / Minor - weld (wall)

  



Manually Connecting Structural Elements 
Establishing connectivity between structural elements is important. Many different types of connectivity may be 
found in a ship. These include plate to plate connections, plate to stiffener connections, stiffener to stiffener 
connections. 

This connectivity captures the functional requirements and will be physically implemented downstream by means 
of joints and piece parts (chocks, transitions, brackets, etc.).

The Manual Connection command is used to make a single connection between compatible elements, i.e. elements 
that can be connected together in a single connection.

This task shows you how to manually connect individual structural elements. 

1.Click the Manual Connection  icon: 

The Manual Connection dialog box appears.

2.In the geometry area or in the specification tree, 
select the structural elements you want to 
connect. 

In our example, two stiffeners.

Any structural elements already connected are highlighted in the geometry area.



3.In the impact column, right-click the first row 
and identify the impact on the system by 
selecting it in the contextual menu displayed.  

Four impacts are available:

●     None: the connection has no impact on the 
system.

●     Interrupted: the connection requires that the 
system be split into one or more sub-
systems.

●     Minor: the connection requires the addition 
of a feature, such as cutback, slot, endcut, 
bevel.

●     Minor + Interrupted

4.Repeat for other rows.

Impacts

Impacts are managed in a customizable CATNls file, CATStrImpactConnectionCode.CATNls. This lets you 
add other impacts or rename existing ones. 

The default location of this file is: downloaddirectory/OS/intel_a/resources/msgcatalog where OS is the 
operating system, for example intel_a (Windows). 

Impacts can then be used as keywords in detail connection catalogs, letting the designer query for detail 
connections satisfying certain impact criteria when physically implementing functional connections.

5.Click the Catalog  icon opposite the Of type field and select a catalog connection or enter a comment 

directly in the Of type field.

Catalog Connections

A sample catalog of different connection types is provided with the product.

●     Click the catalog icon.
The Catalog Browser opens letting you browse and preview the contents of the current catalog.

●     Browse the families and double-click the family of interest.

●     Browse the list of connections and select the one of interest.

●     Click OK in the Catalog Browser.



For information on options in the Catalog Browser, see Using Catalogs in the Infrastructure User's Guide.

6.Set the efficiency.

Efficiency

The efficiency lets you assess the resistance of the connection.

Efficiency is managed in a customizable CATNls file, CATStrEfficiencyConnectionCode.CATNls. This lets you 
add other values or rename existing ones. 

The default location of this file is: downloaddirectory/OS/intel_a/resources/msgcatalog where OS is the 
operating system, for example intel_a (Windows). 

Efficiency can then be used as a keyword in detail connection catalogs, letting the designer query for detail 
connections satisfying certain efficiency criteria when physically implementing functional connections.

7.Check With added piece parts if you know that the physical connection detail will require the addition of features 
(cutback, slot, etc.).

8.Click Preview to visualize functional connections in the geometry area and identify the contact type.

Contact

Contact types are managed in a CATNIs file, CATStrFunCnxPanel.CATNIs. You cannot add types to the 
existing list but you can rename types.

Four types are available:

●     Edge and face for plates.

●     End and run for stiffeners.

Note: A Warning dialog box informs you if the connection cannot be made because selected elements are not 
compatible.

9.Click OK when done to create the connection.

Structural elements are joined together in a single connection.



A structural connection is added to the specification tree under an Assembly Joint entry. Where possible, a joint 
body is also created to identify the published faces at which the connection is established

●     A yellow symbol containing an exclamation mark in the specification tree means that the connections would 
be more judiciously placed elsewhere in the tree.
For example, if connections are within a plating system, it is best to activate the plating system and create 
the connections under the plating system; if between a plating system and a stiffening system, it is best to 
activate the common tree entry just above these systems and create connections there.

●     To edit the structural connection, double-click the Joint Structural View entry in the specification tree.

  



Refining or Modifying Connections 
The Connection Body command lets you: 

●     Further specify your connection by identifying on which geometrical element (face, vertex, edge, 
stiffener support or end, etc.) of the structural plate or stiffener the connection is established. 
This occurs typically when a gap exists between two structural stiffeners and the manual or automatic 
connection could not identify the geometrical element.

●     Modify an existing connection, i.e. modify the geometrical element at which the connection is 
established. 

In the case of plating systems, it is important to specify the faces on which the connection is established. 
This information is used downstream to generate weld seams on drawings.

This task shows you how to further specify a connection.

Have created a connection.

1. Click the Connection Body  icon.

2. Select a structural connection (Joint Structural 
View)  in the specification tree. 

The Connection Body dialog box is displayed.

Connected structural plates or stiffeners are placed 
in Show mode.

If modifying an existing connection, the dialog box 
lists published geometrical elements. These 
elements are also highlighted in the geometry area.

3. Select the geometrical elements of interest to refine your connection: 

You can select faces, edges, vertices, stiffener supports and ends, etc.
Only published items can be selected. To select unpublished items and have them published on-the-
fly, check Publish on-the-fly, then select geometrical elements of interest.

Note: There is no particular order when selecting geometrical elements.

Modifying Geometrical Elements

Select the geometrical element in the dialog box, then click Remove or Replace before selecting 
the new element at which to establish the connection.



4. Click OK when done. 

A joint body is created and added to the specification tree.

  



Creating Physical Plates & Shapes

Create plates: set parameters in the dialog box then select a support plane or surface, and if necessary 
define a contour.

Create shapes: set parameters in the dialog box then select an existing support or define where the 
shape starts and ends.

 If your design table path is not updating properly, see About section catalogs.

Create small assemblies: select a catalog assembly then existing shapes or plates to position it.

Place cutouts: select a plate or shape, a cutting mode and a contour for the cutout.

 Remove and modify cutouts: select a plate or shape then the cutout and click Remove or Modify.

Place standard endcuts: select a shape, then standard endcuts at the start and end of the shape.

Place contextual endcuts: select a contextual endcut, then inputs to define how it is positioned.

Place standard slots: select a plate, then the shape(s) penetrating the selected plate and a catalog slot.

Place contextual slots: select a contextual slot, then inputs to define how it is positioned.

Define cutback: select a shape then a plane.

 Cope plates and shapes:select the strategy, the plate or shape to trim and then limiting elements.

Split plates & shapes: select one or more plates and/or shapes, then a wireframe element.

Merge plates & shapes: select two plates or two shapes.



Placing Standard End Cuts 
An end cut is created on a shape to configure the mating ends for proper connection with another shape or profile and prior to 
applying a weld connection. A sample feature catalog containing end cuts is provided with the product. An end cut is a 
parametric object and, when you place one, it will size itself based on the formulas you defined when creating it. 

This task shows you how to create a standard end cut, i.e. a feature with no contextual inputs. This end cut feature does not 

depend on any external objects (other plates, shapes, planes, etc.) to be placed.

You can also place end cuts with contextual inputs:

1.With your product open, click the Endcut  icon and select the shape to which you want to apply an end cut. An 

alternative method is to select the shape first, then click the Endcut icon.  

The End Cut Type dialog box opens and the Begin and End points of the shape will be indicated.

NOTE: If the shape you selected already has end cuts they will display in the At Beginning and At End fields. The Delete 
button will become active (selectable) only if end cuts are present.



2.Select the Catalog Browser button to define the Beginning end cut type in the At Beginning field. 

The Catalog Selection for Endcut dialog box opens.
  

3. In the Catalog Selection for Endcut dialog box, double-click Standard Endcut, then navigate to the chapter and family that 
contains the appropriate end cut type for the shape being used. 

Standard end cut refers to end cuts with one input. Contextual refers to end cuts with more than one input.

Use the Filter button to narrow your search. Use the wild card (*) symbol at the end of the keyword (e.g., ENDCUT*) to 
include all entries with the keyword "endcut".

The selected end cut type will preview in the Catalog Selection for Endcut dialog box. Zoom in to enlarge the image in the 
preview and to visualize the surface and edge parameters.



If the parameters of the end cut do not match those of the shape you will be advised of mismatched or undefined parameters. 
An end cut is a feature that resides in a CATPart; therefore this condition must be corrected using Part Design. 

4.Click OK in the Catalog Selection dialog box when you have selected the end cut. 
5.Click Parameters... in the End Cut Type dialog box. 

The Parameters dialog box will open. This displays the default parameters for the end cut you selected. The number of 
parameters will differ depending on the end cut type. Change the parameter values as necessary, then click OK. 



This will return you to the End Cut Type dialog box.  

 6.Repeat to define the end cut type at the other end of the shape (at End field).
7.Click OK in the End Cut Type dialog box when done. The end cut is created. 

 



Defining Cutback 

 The Cutback command lets you define how shape ends are cut. 

This task shows how to trim a shape to a plane. 

No sample document is provided.

 

 

1. Click the Cutback  icon.

The Cutback dialog box appears.

The Trim to plane type is the default type.

2. Select the shape you want to trim.

3. Select the plane to which you want to trim the shape:

The plane can be a plane, face, surface, plate or another shape.

4. Click OK to create the cutback.

Shapes are trimmed to the plane defined by the 
trimming member and the cutback is identified in 
the specification tree.

Curved shapes cannot be trimmed because the cutting plane may intersect the curve at more 
than one location.





About Section Catalogs

Sections can be created from the following big scale or standard scale catalogs:
●     AISC_BigScale.catalog

●     AISC_StandardScale.catalog

●     EN_BigScale.catalog

●     EN_StandardScale.catalog

●     OTUA_BigScale.catalog

●     OTUA_StandardScale.catalog

●     DIN_BigScale.catalog

●     DIN_StandardScale.catalog

If you get the following message when creating a section:

The source file of the design table AISC_XX wasnt found. The design table is in broken state 
while this file isn't found.

The design table path is not updating properly to reflect the catalog location.

You will have to enter the correct path for the design table. This is done in one of two ways:

A. Via Tools -> Options

1.  Select Tools -> Options -> General -> Document
2.  Click Other folders under Linked Document Localization, then click Configure...
3.  Select the appropriate design table path from those listed below:

../OS/startup/components/StructuralCatalogs/AISC/DesignTables for AISC catalogs

../OS/startup/components/StructuralCatalogs/OTUA/DesignTables for OTUA catalogs

../OS/startup/components/StructuralCatalogs/EN/DesignTables for EN catalogs

../OS/startup/components/StructuralCatalogs/DIN/DesignTables for DIN catalogs

4.  Click Add, then OK when done.

Or,

B. Via the Properties Command

You must change the design table path for each part linked to a parametric catalog. Parametric sketches 
are located in:

../OS/startup/components/StructuralCatalogs/AISC/Models for AISC catalogs

../OS/startup/components/StructuralCatalogs/OTUA/Models for OTUA catalogs

../OS/startup/components/StructuralCatalogs/EN/Models for EN catalogs



../OS/startup/components/StructuralCatalogs/DIN/Models for DIN catalogs

1.  If needed, modify the rights of CATPart documents.
2.  Update the design table path:

●     Open the part (File -> Open)

●     Right-click the Relations/Design Table entry in the specification tree and select Properties 
in the contextual menu.

●     Update the path:

../OS/startup/components/StructuralCatalogs/AISC/DesignTables for AISC catalogs

../OS/startup/components/StructuralCatalogs/OTUA/DesignTables for OTUA catalogs

../OS/startup/components/StructuralCatalogs/EN/DesignTables for EN catalogs

../OS/startup/components/StructuralCatalogs/DIN/DesignTables for DIN catalogs

3.  Update the part and then save it.



Design Assistant 

This tasks shows you how to use the design assistant. 

This feature aids the designer in identifying and analyzing the relational situation between objects, for 

example, in a ship structure. These situations are categorized into three basic groups; limits (contact), 

clashes, and connections. You can use the Design Assistant to display graphically a specific conflict and a 

proposed resolution on the fly. 

These terms are defined as follows: 

●     Limit/Contact: contacting objects (connections may be missing)

●     Clash: hard clashes with objects (requires attention or redesign)

●     Connection: proper connection between objects

To reduce unnecessary computer processing time when analyzing object relations you will need to make 
some changes in the Tools - Options settings. 

Go to Tools - Options, select Digital Mockup, DMU Space Analysis then click the DMU Clash - Detailed 
Computation tab. Change the settings if necessary for Level of Detail, Clash Result and Numeric Result to 
match those shown below.



The Design Assistant feature supports products designed in Structural Preliminary Layout, Structure 
Functional Design and Ship Structure Detail Design. A product (or model) may contain one or all of the 
following:  

●     Conceptual objects - associated with the Structural Preliminary Layout application

●     Functional objects - associated with the Structure Functional Design application

●     Detail objects - associated with the Ship Structure Detail Design application

1.With your product open, click the Design Assistant icon . 

The Design Assistant dialog box opens.

Click the Tree tab. 

In the example, below, the (relations) tree expands at the Product level to show the related Conceptual 
objects. In the preview window you can zoom and rotate the image just like in the 3D viewer.



An object can be selected (picked) in the main product, from the specifications tree, or from the 
relations tree that displays when the Tree tab is selected.  

The Tree tab will display up to three levels; parent, current object and children. You can navigate in the 
tree structure or select a new object in the main product while the Design Assistant is open.

The Limits, Space Analysis and Connections tabs will become active only when the selected object is an 
individual element, i.e., it is a child of a parent group. 

If the current selected object is not of the corresponding product type (Conceptual, Functional, Detail 
Structure) the Tree view will only display the current object (no parent or children relations are 
displayed). For example, if the current selected object is Deck_001 (conceptual) but the option 
Functional is active, only the current object, Deck_001 will display.

2.Activate the Functional option to view related functional objects. 



3.Navigate in the specifications tree, the relations tree or pick from the main product, and select an object 
of interest. As the tabs become available you can view the Limits, Space Analysis and Connections 
situations for that object.  

In the example below, a deck has been selected to view Limits. In the Visualize column, toggle the Y/N 
to show or hide an object.

4.Click the Space Analysis tab to display the analysis of related objects at the selected level (in the tree). 
You can filter the list by selecting All Type, Contact or Clash. 



5.In a similar manner, select an object in the specification tree so that the Connections tab displays.  

Take some time to experiment with the several combinations of tab selection, object type and filter 
selections and observe the available information.

6.Click Close when done.



Managing Your Project
Managing Project Resources
About the Feature Dictionary
About Object Naming Rules
About Molded Conventions
About Project Parameters 

  



Managing Project Resources
Project resources are typically managed by system administrators. Typically this involves entering 
information such as folder paths for resources, like user dictionaries such as the feature dictionary, 
without which the application cannot function. What administrators enter will be visible in the Browse tab 
of the Project Resource Management dialog box (Tools -> Project Management -> Select/Browse...), 
but it cannot be changed there.

 A sample project resource management file is provided and by default, the application will start with this 
file. The following Ship Structure Detail Design-related resources are managed in this file.
Project Resources

●     Feature dictionary managing object classes

●     Discrete values for attributes: directory used to store discrete values of attributes.

●     ID schema managing object naming rules

●     ID sequence number directory: contains the last sequence number that was generated for an object.

●     Reference grid system: a CATPart containing default sets of reference planes in each of the three ship 
directions.
The default location for this resource is 
...OS/startup/EquipmentAndSystems/Structure/ReferenceGridSystem.CATPart

Structure Discipline Resources

 
●     Project parameters: contains setup parameters for ship directions and characteristic planes

The default location for this resource is ../OS/startup/EquipmentAndSystems/Structure

 
●     Molded conventions: contains a set of rules that give default orientations when placing structural 

elements

The default location for this resource is ../OS/startup/EquipmentAndSystems/Structure

●     Orientation conventions: contains naming conventions for ship directions. Default conventions are USA 
conventions contained in sample CATStrOrientNamingUSAConv.
Sample naming conventions for European conventions is also supplied: 
CATStrOrientNamingEURConv.  

The default location for these resources are .../OS/resources/msgcatalog 

●     Structure detail design openings catalog: contains two chapters, one for positioning features and one 
for opening shapes.
The default location of this resource is

.../OS/startup/EquipmentAndSystems/StructureDetailDesign/
FeatureCatalogs/Parametric/Openings/SddOpenings.catalog



●     Structure openings catalog. The default location of this resource is 
.../OS/startup/components/StructuralCatalogs/OPENINGS/SFD_OpeningsBigScale.catalog

●     Naming section characteristics: a file mapping user names for section characteristics to different 
categories of shape (I, C, T or L).
The default location for this resource is CATStrSectionNamingKeys

●     Structure sections catalog: contains structure sections identified in accordance with  user names for 
section characteristics.
The default location of this resource is 
.../OS/startup/components/StructuralCatalogs/AISC/AISC_BigScale.catalog

●     Structure sections path: identifies the path of the folder in which the list of available sections will be 
stored. You will note that this entry has been commented out. The system detects the location of this 
folder in transparent fashion for the user. 

However, you can customize this location to, for example, have all sections centrally located or 
override the default behaviour. If you do so, do not forget to uncomment this entry. In this case it is 
recommended that you create an empty folder for available sections and that you identify the path to 
this folder in a customized project resource management file. 
You can also, if desired, initialize a section list for the user.

●     Structure materials catalog: defines all materials and grades available to the structural engineer.
The default location for this resource is 
.../OS/startup/components/StructuralCatalogs/Materials/StructureMaterials.CATMaterial

Note: No tiffs letting you view objects in the Materials mode have been delivered.

●     Thickness table: defines all plate thicknesses available to the structural engineer. A sample table in 
text format is supplied. The system administrator can modify or add to the sample thickness table, or, 
if needed, create a new table. 

The default location for this resource is 
.../OS/startup/components/StructuralCatalogs/ThicknessTables/ThicknessListSample.txt

Important: If you change a thickness value in an existing design table, all plates of this thickness 
linked to the design table will be updated to the new value. With this in mind, you may prefer to add a 
row for the new thickness or create a new table. 

 
●     Structure drawing symbols catalog

The default location for this resource is
.../OS/startup/components/StructuralCatalogs/DrawingSymbols/Structure2DSymbols-
Customization.catalog

●     Structure detailing features catalog: contains slots, endcuts and assembly templates. The default 
location of this resource is 
.../OS/startup/EquipmentAndSystems/Structure/DetailingFeatures/FeatureCatalogs/
Parametric/DetailingFeatures.catalog

Ship Structure Detail Design Application Resources

●     Structure connection details catalog: contains structure connection details. The default location of this 
resource is .../OS/startup/EquipmentAndSystems/StructureDetailDesign/FeatureCatalogs/
Parametric/StructureConnectionDetails.catalog

Note: .../OS where OS is the operating system, for example intel_a (Windows) to be found in the 
download folder.



ENOVIA-based Resources

When you change from using file-based resources to ENOVIA-based resources, you must go through the 
PRM file and change the "Driver" entry to "ENOVIAV5" and the "Location" entry to the file name of the 
resource without the file extension. This must be done for all resources, typically the structure materials 
catalog and the sections catalog, that have been placed in the ENOVIA database.

●     If there is more than one project at your site, then a project resource management (PRM) file is made 
for each project. You can select another project using the PRM command (Tools -> Project 
Management -> Select/Browse...). 

●     For more information on resources and how the resource management file is organized.

  



Using the PRM Command

This task shows how you can select a project for your session.

1.
From the appropriate CATIA workbench, launch the project resource management (PRM) command by 

selecting Tools - Project Management - Select/Browse from the menu bar.

The Project Resource Management dialog box is displayed:

Note that when the dialog box opens the last project that you used is selected.

The Select tab lists all the XML projects setup found in the directory defined by the environment 

variable CATDisciplinePath. This list begins with a CNEXT project which contains only the applications 

with their resources as defined and delivered with CNEXT.

 2. Select the project of your choice, here Project.
The corresponding PRM file is read and the disciplines it contains are listed. 

3. Select the corresponding discipline, here Piping. Click OK to use the project and discipline you have 
selected. 



4. The following step is used for informational purposes only - to see a list of resources for a particular 
discipline. To select a project you only need to take the steps explained above.

Select the Browse tab. Once a project and a discipline have been selected, the dialog box lists all the 
applications defined for the chosen discipline, the description of the active application, and  the list of 
resources of that application. The list of resources displayed is always that for the active application.

You should also note that the applications displayed include the applications under that particular 
discipline, and any applications that are at the project level, which means above the discipline in the 
PRM hierarchy. In the example below, the Piping discipline displays Piping Design and PID, which are 
part of that discipline. It also displays the Equipment, Hanger Design and Penetration Management 
applications, because some of their resources have been placed at the project level. The reason for 
placing them at the project level is that most disciplines make use of these applications.

When the Project Resource Management dialog box first displays, as explained in Step 1, it may contain a 
third tab - XML Parsing Error. This indicates that there is an XML syntax error in the file that corresponds 
to the Project you have chosen.

Click the XML Parsing Error tab to display the error, as shown in the image below. 



You will need to correct the PRM file to get rid of the error. 

Errors in defining resources in the PRM file are explained in Checking a PRM File for Errors.

http://pc220dsa/MARCXR15/doc/online/ucfug_C2/ucfugcu0702.htm


Understanding Project Resource Management
This task shows you how to manage project resources like catalogs and dictionaries. These changes can only be 
made at system administrator level. 

For a more complete list of resources and flags see List of PRM Resources and Flags.

 

The project resource management (PRM) file identifies resources (such as line list catalogs, user dictionaries, 
etc.) to the application. Specifically, the PRM file identifies each resource and its location (directory path). The 
PRM file also organizes the resources by discipline and application, associating resources to specific applications. 
Therefore, you get the correct resource, equipment catalog for instance, for the resource you are working in. 

It's hierarchical structure allows you to share resources, so that you do not have to place duplicate copies of the 
same resource in several directories.

The PRM file is also used for certain other purposes, such as setting flags. These are explained below.

A sample file is provided with this application, and it is best to make a copy of it and edit it. The default location 
is ...intel_a\startup\EquipmentAnd Systems\ProjectData and the file is named Project.xml.

The application will function even if the user does not enter information particular to his site,  but nothing can be 
saved. Therefore, the first task an administrator needs to do is enter information relevant to his site or project.
1.If there is more than one project at your site you will need to make a project resource management file for 

each project. You can name the file anything you want to and change its location too (see below). However, 
you must set the variable in the Environment Editor. You do this by opening the Environment Editor dialog box 
and entering against the line CATDisciplinePath the directory in which your project resource management 
files are: 

If you have more than one project resource management file then by default the application will start with the 
file named Project.xml, if there is such a file, or the last file used. If you wish to select another resource 
management file you must open it by clicking Tools - Project Management. Go to the Select tab and select 
the file and discipline you need. This dialog box shows each resource available to you, unless the value of 
"Visible" (see below) against a resource or application is set to No.

2.The resource management file is organized into several sections to make it easier to manage and utilize 
resources. The image below shows its hierarchical structure, with an exception, which is explained below. 
"Other disciplines" refers to other disciplines like Tubing, or AEC V4 to V5 Migration Discipline, that are placed 
at the same level. They are not shown in this image for reasons of space. 

http://pc220dsa/MARCXR15/doc/online/ucfug_C2/ucfugcu0705.htm


The Project box refers to the project for which the PRM file has been created, and will frequently be identified 
by the file name. In this case it is Project.xml.

When you look at the Project.xml file you will see that the resource listings begin with project resources. 
Any resources you place under the heading Project Resources can be used by all applications that are included 
in the file. In the sample file you will see items like zones, feature dictionary and application-generated object 
names in this section. All disciplines and applications shown under project resources will be able to access the 
resources identified under the heading project resources.

The next level is the discipline level.  All resources placed under a discipline, such as Piping, can be used by 
all the applications which are listed under it. In the example above, Piping Diagrams, Piping Design and 
Equipment applications are shown under the Piping Discipline. Resources such as various catalogs and report 
definitions are listed at the discipline level and can be accessed by all applications that belong to that 
discipline.

The next level of resource management is the application itself. Any resource referred to at this level can only 
be used by that application. Resources like catalogs, files that contain connector attributes and resolved parts 
directories are listed at this level.

Equipment Arrangement and Hanger Design have been placed under several disciplines. These applications 
are considered multi-discipline because their resources are used by all disciplines. When you are working in 
these disciplines you may need Equipment or Hanger resources. However, in different disciplines you may not 
use the same resources from Equipment Arrangement or Hanger Design and this structuring allows you to 
place different different resources under each discipline. For instance, under the Piping Discipline, Equipment 
Arrangement may have a different catalog (with Piping related equipment only) than under the HVAC 
Discipline.



Equipment and Hanger applications have also been placed at the project resource level, primarily to allow 
sharing of resources, under the headings "Equipment Application Resources" and "Hanger Design Application 
Resources."

To explain: If you are working in Piping Design you are in the Piping Discipline. You select the discipline by 
clicking Tools - Project Management, or simply by opening an application, which will activate the correct 
discipline. For this to happen your PRM file must be set up correctly.

Now, while in the piping workbench, you want to place equipment in your document, and you launch 
Equipment Arrangement. When you do so you will only have access to equipment resources that are identified 
in the PRM file under the piping discipline, for instance the "piping equipment catalog," containing piping 
related equipment. But let us assume that in your project you have certain types of equipment that are used 
by all disciplines. You can create a catalog that contains all this common equipment and identify it under 
"Equipment Application Resources" at the project level (it should not be identified under discipline also). When 
you do this you will have access to this catalog when you open Equipment Arrangement under any discipline. 

Some applications have the entry "Visible = yes". If you set the value to No then this application cannot be 
used and will not be visible in the Tools - Project Management dialog box.

3. A resource entry looks like this:   

<Resource Name="PipingIDSchema" Description="Piping ID Schema Directory">

<ID Type="Path" Driver="File" Location="..\..\EquipmentAndSystems\Piping\DataDictionary"/>

</Resource>

●     You should not change the Resource Name, even if you replace a resource with a different one. 

●     You can change the Description if you want to - this is a brief explanation of the resource.

●     The Type field refers to file type. If the Type field says Catia, it refers to a file type unique to Catia, such 
as .catalog. The type Misc is used for resources which are of a type not unique to Catia and must be 
opened in another way. The type Path is similar, except that in the Location field only the directory in 
which the resource is located is named. 

●     If your resources do not reside in Enovia, enter File in the Driver field. Define the Location field as 
follows: As shown in the resource example above, the location entry is relative - it is relative to the entry 
you made in the Environment Editor as shown in Step 1. The entry in the location field will be added to the 
entry you had in the Environment Editor and it is in that location that the application will look for the 
resource. Which is why it is preferable to enter absolute paths - including the drive letter - in the location 
field. 

●     If your resources are Enovia-based, enter EnoviaV5 in the Driver field. For Enovia-based resources, all 
you need to enter in the Location field is the file name of the resource without the file extension. For 
instance, the catalog PipingParts.catalog would be entered as PipingParts. 

●     The Location field usually gives the location of the resource. If this is a directory path then you can 
change the location, with an associated change in the PRM file. This entry is sometimes used to enter a 
value for a flag or behavior, such as 0 or 1, or True and False.

●     Some resources have the entry "Visible = yes". If you set the value to No then this resource cannot be 
used and will not be visible in the Tools - Project Management dialog box.

●     Some resources have the entry Access="RW" or "R". These refers to file permissions: read-write or 
read.

When you change from using file-based resources to Enovia-based resources: You must go through the PRM 
file and change the "Driver" and "Location" entries as noted above. This must be done for all resources that 



have been placed in the Enovia database.
4.The Project Resources listed in the sample Project.xml file are described in following sections, beginning 

with the resources referred to under Project Resources: 
●     ID schema resources: The "location" lists the directory where the rules for naming objects are stored. 

Use the default location provided in the sample file. You need to have this for every application you use. In 
addition, there is an entry for "MultiDisciplineIDSchema." This location is used for objects -such as zones - 
that are used by all disciplines. 

●     User dictionary resources: In the location field enter the name of the CATfct file for each application. 
You do not need to enter the location. The CATfct file is used to store all the classes and attributes created 
by you. The default names for CATfct files in each application are included in the sample project.xml file 
and you should use these names unless you have created a different CATfct file, or changed the default 
name. There is also a MultiDisciplineUserDictionary - this CATfct file can be referred to by all applications.

●     Zones catalog: The zones that you create need to be stored in a catalog accessible to all users, because 
they are shared. The default location is CATMldZone.catalog. Even though zones are only created in 
schematic applications, other applications may use them when documents are moved from schematic to 
3D. Enter a different name or location if you change them.

●     Discrete values: Many attributes have discrete values and this directory is used to store them. 

●     Schematic driven: This is a flag that needs to be set for schematic driven routing and parts placement. If 
the value of "Location" is set to 0 then individual users can check or uncheck an option that allows 
schematic driven 3D design.  If the value is set to 1 then the option "schematic driven" is always selected 
and users cannot uncheck it. (In Equipment Arrangement, schematic driven parts placement is not 
possible if the Function Driven flag is set to 2.)

●     Delete Part On Run: This entry is used to control whether all parts on a run will be deleted when you 
delete the run. If you enter the value of "Location" as 1 then the parts will be deleted. If you enter the 
value 0 then the parts will not be deleted when you delete the run.

●     Graphic representations: When you create graphic representations for a part you need a file in which to 
store the categories (single, double, etc.). That file is created within an application, as you will see later. 
There is also a file under Project Resources because the categories must be available to all applications. If 
you add a new category you must include it in this file too. Enter a new location and file name if you want 
to change them.

●     Penetration openings catalog: The profiles of the holes you may want to make through walls and 
partitions to pass pipes and ducts are noted in this catalog. If you make a new profile you must enter it 
here too. Enter a new location and file name if you want to change them.

●     ID Sequence Number directory: The IDSequenceNumbers directory contains the last sequence number 
that was generated for an object. You should specify a location for it.

●     Importer CATfcts: This lists the location of your CATfct files, and is used when migrating V4 models to 
V5. If you change the location of the CATfct files you must enter the new location in the "Location" field. 
You do not need to do anything if you continue to use the default location.

●     Reference Grid System: Location of the CATPart that contains the reference grid definition used by 
applications. You need to modify this entry if you change the location of the CATPart or rename it.

●     Discipline super class: This is a text file that lists the object classes that will be visible in a class browser 
when you are in the Equipment Arrangement workbench. You can have files at project, discipline and 
application level. The filter will only work with a user-generated PRM file.

●     Computed attributes: This entry shows the location of the ComputedAttributes.txt file. The computed 
attributes contained in this file will display in the Properties dialog box. You can change the location of this 
file, and update the PRM file accordingly. You can also change the entries in the file.

●     Unique reference part number options & partially resolved reference part number options: These 
two entries define how a placed part will be named. 'Unique reference' parts are those that have at least 
one property (or all properties) that can have infinite values. An HVAC duct is an example. 'Partially 
resolved' parts are those in which the values of all properties are defined by a design table. Valves are an 
example. In this entry, if you enter 1 in the Location field then the name of the placed part will be derived 
from the design table. If you enter 2 then the name will be derived from the object naming rules.

●     Publication Based Connections: This entry controls whether publication based connections will be used 



when establishing connections between elements in different work packages. When this flag is on (the 
value in the Location field is 1), the system will use publication based link technology. This link technology 
is intended to improve support for configuration management, revision management and concurrent 
engineering. When working in an ENOVIA environment, publication based connections are used for all 
cross document connections, regardless of the setting of this resource.

5.The next level, as explained above, is the Discipline level. Resources placed under the Discipline category 
can be used by all the applications in that discipline. 

The sample Project.xml file places the following resources at the Discipline level. Each entry names the file and 
gives its default location. If you intend to use different resources, which is likely, then you must enter the new 
file name and location, as appropriate. The following resources are referenced, but not all disciplines will have 
all of these resources. 

●     Specifications catalog

●     Insulation specifications catalog

●     Material specifications catalog

●     Standards catalog

●     Design rules: You need to use the default location and file name

●     Parts catalog name and location: contains parametric parts

●     Piping lines shared catalog: The file where shared piping lines are stored and its location.

●     Sample data directory: This is the location where the reports you run will be stored.

●     Report definitions directory: The formats (definitions) you create for running reports are stored in this 
directory.

6.In addition to resources placed at the Project and Discipline levels, resources are also placed at the 
application level and are only available to the application under which they are placed. 2-D applications 
have all or most of the following resources. 

●     Component catalog: The parts catalog.

●     Shared instrument lines catalog.

●     Annotation catalog.

●     Sample data directory: When you create graphic representations for a part you need a file in which to 
store the categories (open, closed, etc.). If you add a new category you must include it in this file too. 
Enter a new location and file name if you want to change them.

●     Design rules for Equipment Arrangement: This is used when assigning a part type to a 2D part.

●     The parts catalog for Equipment Arrangement: This is used when assigning a part type to a 2D part.

3-D applications will have most of the following resources or entries.

●     Graphic representations file: When you create graphic representations for a part you need a file in which to 
store the categories (single, double, etc.). If you add a new category you must include it in this file too. 
Enter a new location and file name if you want to change them.

●     Connector attributes file: This file lists the attributes that will be inherited (from the part) by a connector 
when you are placing it on a part. If you want to make changes to the attributes you want a connector to 
inherit you must do it in this file. Do not change the name of this file.

●     Resolved parts: When you place a parametric part in a document it assumes specific dimensions. Once a 
part has specific dimensions it is placed in the Resolved Parts catalog. The location of the default Resolved 
Parts catalog is listed here.

●     Design rules: You need to use the default location and file name.



●     Parts catalog name and location: contains parametric parts

●     Report definitions directory: The formats (definitions) you create for running reports are stored in this 
directory.

●     Graphic 2D Symbols Catalog: For Piping, this is the catalog in which the 2-D equivalents of 3-D endstyles 
are stored. For Equipment, this catalog contains 2-D symbols for center of gravity. See Drawing Production 
for more information.

●     Growth Factor: Some applications allow you to reserve space in some parts for future growth. You can, for 
instance, reserve space in a conduit for future growth. The space saved for future growth will be equal to 
the value you enter in the "Location" field. If you enter 0.2 it means that 20 percent of the space in a 
conduit will be reserved for future growth and you will only be allowed to use 80 percent of the space in it.

●     Function Driven: This is a flag that controls parts placement in Equipment Arrangement. The value in the 
Location field dictates: 1 - Function driven equipment placement is possible; 2 - Only functionless 
equipment placement is possible. (Schematic driven parts placement is not possible in Equipment 
Arrangement.); 3 - Both function driven and functionless equipment placement are possible (a final Tools - 
Options setting is needed. See Functionless Parts Placement in Equipment Arrangement documentation.)

●     Hanger Cable Clearance: The value in the Location field is the cable clearance, in millimeters. This value 
plus the diameter of the cable you are routing must be less than the tier spacing of the hanger. The cable 
clearance value is assigned when a hanger is placed.

●     HVAC Up Direction: The value in the Location field determines the 'Up' direction of a part that is placed on 
a run. There are two numerals in this field - the first dictates the up direction for a part placed on a 
horizontal run, the second is for a vertical run. Thus, if the value is 00, the Up direction will the same for 
both horizontal and vertical runs. The values are: 0 - follow the run's Up Direction; 1 - Up direction will 
follow the X axis; 2 - follow Y axis; 3 - follow Z axis.

7.The AEC Migration Discipline refers to a product that enables you to migrate V4 models to V5. It has Piping 
Design, Piping and Instrumentation Diagrams, Equipment Arrangement, Tubing Design and HVAC Design 
resources under it.  

Most resources have been described above and do not need further explanation. Enter the location and file 
names if they are different from those in the sample Project.xml file.

In addition, under the heading AEC V4 V5 Migration there are several options you should know about. They 
are explained below.

AEC V4 V5 Migration

There are several options that you need to set to True or False. The first several are about migrating data to 
Piping and Instrumentation Diagrams, Piping Design, Equipment Arrangement, Tubing Design and HVAC 
Design and Structures. If a V4 model has data of all these types, but you have set two of them to False, then 
you will only receive V5 data relating to the applications set to True. If you want data of all types to be 
migrated then you must set all the options to True.

Other options are:

●     Create runs without parts: If set to True a run will be migrated without the parts.

●     ImportPipingLine (or other type of line): If set to True a line will be created in the V5 Piping Line catalog if 
it does not exist. When set to False, the migration process will stop if the line does not exist in V5.

●     Mapping Table: You need to enter the location and name of the migration mapping table if you change the 
default name or location.

●     MigratedPIDNoShowSheetFormat: The sheet format (also known as title block) will not be visible if the 
value of "Location" is set to False.

●     MigrateXXXWithMissingLines: If set to True the sheet will be migrated even if some Lines cannot be. If set 



to False the migration process will stop if missing lines are encountered.

●     MigratedXXXSheetSize: Enter the size in the Location field:  Letter, Legal, A0, ISO/A1, ISO/A2, ISO/A3, 
ISO/A4, ISO/A, ANSI/B, ANSI/C, ANSI/D, ANSI/E, ANSI/F, ANSI).

 8.In addition to some of the resources explained above, the Structure Discipline includes the following 
resources or entries: 

●     Sections catalog: If you change the default location of the AISC_BigScale catalog then enter the location in 
this entry. The location should include the directory AISC in which the catalog should reside, so that the 
path reads: ......AISC\AISC_BigScale.catalog.

●     Structure sections path: The path of the directory in which the available sections are stored. The default 
location is ...startup\components\StructuralCatalogs\ModelsResolved.

●     Structure Thickness List: This is the location of the thickness list sample file, which contains the list of 
thicknesses that can be applied to a plate.

●     Structure openings catalog: Location of the openings parts catalog.

●     Structure materials catalog: Location of the structure materials catalog.

●     Structure detail design: Location of the catalog that contains user defined features.

●     Naming section characteristics: Location of the NLS file that lists names of sections whose names should 
not be changed. This is for internal use. Do not change anything in this entry.

●     Structure Functional Connections Catalog: Location of the Structure Functional Connections Catalog. This 
catalog contains the names of connection types between objects.

●     Project Bounding Box: This specifies the dimensions of your project - if you are designing a ship then it will 
be set within these dimensions. You can define the unit used for measuring - the default is millimeter - and 
change the default values for each direction. The values are measured from the origin (000).

 
9.Make sure to save your changes.

  



About the Feature Dictionary
The feature dictionary manages object classes. In the sample dictionary provided with the application, four object classes 
are managed: plating, inserting, rolled section grouping stiffening and beaming, and opening. 

Note: In the application, these object classes are managed via the class browser. 

To view the sample dictionary:
1.Open the CATStructureDetailDesignSample.CATfct file. 

By default, this file is located in the install_folder under /resources/graphic.

The Feature Dictionary Editor opens showing the sample dictionary.

The Classes View displays all the classes available in the document, i.e. the predefined classes included in the application.

2.Expand the Classes View to display predefined classes.



You can add sub-classes and attributes to the sample dictionary, or if you want, you can create a new feature dictionary. 

For more information, see Using the Feature Dictionary Editor in the Infrastructure User's Guide.

  

http://pc220dsa/MARCXR15/doc/online/basug_C2/basugat1300.htm


About Object Naming Rules
Ship Structure Detail Design provides a set of default naming rules or unique identifiers for the objects 
you create. This identifier consists of a prefix that identifies the type of object it is, followed by a unique 
number.

You may want to modify these rules to suit your own requirements: 

●     For objects such as plating, stiffening, beaming, etc. integrated in the feature dictionary, use the 
Define/Modify ID Schema command in the Feature Dictionary Editor application.

●     For all other objects, you must edit XML files directly.
By default, sample XML files are located in the install_folder under 
startup/EquipmentAndSystems/StructureDetailDesign/DataDictionary.

Modifying or defining object naming rules is typically performed by an administrator. 

For more information, see Modifying the Object Naming Rules in the Infrastructure User's Guide.
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More About Catalog Slots, Endcuts & Small 
Assemblies

Catalog slots, endcuts and small assemblies are managed by an administrator. Typically this involves enriching 
and updating the sample catalog of industry-specific features provided with the product. This is the catalog 
users access when placing features on physical plates and shapes and creating small assemblies.

Creating Catalog Slots
Creating Catalog Endcuts

Creating Catalog Small Assemblies
Storing Slots, Endcuts and Small Assemblies in a Catalog

Rules and Recommendations



More About Openings
Defining Positioning Strategies for Openings
Defining Parametric Contours for Openings

Openings Catalog 

  



Defining Positioning Strategies for Openings

This task explains how to create a positioning strategy for openings. This is usually done by an 

administrator.

To customize the positioning of openings, the administrator can add his own positioning strategies to the 

sample catalog supplied with the product. 

Positioning strategies are user features defined as follows.

Basically, user features can take any kind of geometry as input but must return the following outputs: 

●     3 perpendicular planes representing an axis system named: Support, Plane_Normal_To_H and 

Plane_Normal_To_V 

●     1 Axis named Axis representing the intersection of Plane_Normal_To_H and Plane_Normal_To_V.

       

Note: The outputs of the positioning strategy are used to position sketches and the user feature contour 

when in the Opening command .

This task is based on a strategy using 1 support, 2 reference planes and 2 offsets.

1. Open a new CATPart in the Wireframe and Surface Design workbench and insert two empty 
openbodies named Inputs and Outputs.



2. Define your input data in the first openbody. For this, we need 1 support and  2 reference planes. 

 



3. Define the output data :  
●     1 Support (zero offset from the Support_Plane)

●     1 Plane_Normal_To_H (at an offset from the First_Reference_Plane)

●     1 Plane_Normal_To_V (at an offset from the Second_Reference_Plane)

●     1 Axis (intersection of Plane_Normal_To_H and Plane_Normal_To_V)

4. Select Insert -> UserFeature -> UserFeature Creation... 

The Userfeature Definition dialog box opens. 



●     Give the user feature a meaningful name

●     Select the Outputs openbody.
In most of cases, the system should automatically retrieve the inputs defined in the Inputs 
openbody. If this is not the case select components in the Inputs of components column.



5. Select parameters to publish :
●     First_Offset (offset between First_Reference_Plane and Plane_Normal_To_H)

●     Second_Offset (offset between Second_Reference_Plane and Plane_Normal_To_V)



6. Select the four output elements:



7. Click OK when done. 

The user feature is created under the Knowledge Templates entry in the specification tree.



 
8. Save the document.
9. Store the user feature in the sample catalog SddOpenings.catalog.



Defining Parametric Contours for Openings

This task explains how to create a parametric contour for openings. This is usually done by an administrator.

This involves creating a user feature based on a parametric sketch which takes 3 planes as

input. The sketch is constrained in position by the 3 planes.

1.Open a new CATPart and create your parametric sketch. 

 



2.Insert a new body (Insert -> Open Body) named Inputs and create 3 planes and 1 axis under this openbody: 

●     3 perpendicular planes representing an axis system named: Support, Plane_Normal_To_H and 

Plane_Normal_To_V 

●     1 axis named Axis representing the intersection of Plane_Normal_To_H and Plane_Normal_To_V.

        



3.Constrain the sketch: right-click the sketch and select Change Sketch Support from the contextual menu. 

The Sketch Positioning dialog opens.



4.Complete the dialog as follows and click OK when done. 

5.Select Insert -> UserFeature -> UserFeature Creation... 

The Userfeature Definition dialog box opens



●     Give the user feature a meaningful name.

●     Select the sketch.
In most of cases, the system should automatically retrieve the inputs 
defined in the Inputs openbody. If this is not the case, double-click on Axis in the Inputs of
components column to keep the 3 planes only.



6.If you have defined a design table associated to your sketch then select the Parameters tab and
publish the configuration.



 
7.Click OK when done. 

The user feature is created under the Knowledge Templates entry in the specification tree.



8.Save the document.
9.Store the user feature in the sample catalog SddOpenings.catalog.

  



Openings Catalog

A sample catalog, SddOpenings.catalog of positioning strategies and parametric contours is provided 

with the product. By default, this catalog which is managed as a project resource is located in folder

...\OS\startup\EquipmentAndSystems\StructureDetailDesign\FeatureCatalogs\Parametric\Openings.

Enriching and updating the sample catalog is recommended. This is usually done by an administrator.

1. Open the sample catalog SddOpenings.catalog. 

The Catalog Editor workbench opens showing the contents of the sample catalog.

 
2. If necessary, expand the chapters to view their contents. 

Two chapters have been defined: SddPositioning and SddShapes. Each chapter corresponds to a folder 
containing the associated features.
It is important to respect the tree structure and to add your new positioning strategy in the positioning 
family and to add your new family contour in the SDDShapes folder.



Structure Detail Design Package in Knowledge 
Expert

A Ship Structure Detail Design package is support by Knowledge Expert. This package can be accessed 
via the object browser and objects, attributes and methods in the package used in expert relations.
This package contains the following main objects: 

●     CATSddBeaming

●     CATSddInserting

●     CATSddOpening

●     CATSddPaneling

●     CATSddPlating

●     CATSddStiffening

●     CATSddStiffeningOnFreeEdge

●     CATStrJointExt

All other objects listed in the browser derive from the above main objects, for example DeckPlate derives 
from CATSddPlating. These objects or sub-classes are managed in the sample feature dictionary.

For information on object attributes and methods, see Ship Structure Detail Design in the Reference 
Information section of the Knowledge Expert User's Guide.

  



Interoperability with ENOVIA LCA
The ENOVIA product line provides the PDM component of the overall solution. With ENOVIA LCA, users can 
effectively manage the entire product life cycle of their data, including data management, work flow 
management, people and organization management, and many other aspects of their product and business.

Please refer to ENOVIA documentation for more detailed information on specific ENOVIA usage and 
functionality.

Optimal CATIA PLM Usability
Recommended Methodology 

 



Workbench Description
The Ship Structure Detail Design Version 5 application window looks like this:

Click the hotspots to see related documentation.

Menu Bar
Block Toolbar

Structural Systems Toolbar
System Interactions Toolbar

Physical Plates & Shapes Toolbar
Tools Toolbar

Keyboard Shortcuts 



Menu Bar
This section presents the menu bar tools and commands dedicated to Ship Structure Detail Design.

Start File Edit View Insert Tools Window Help

Insert

For... See...

 

 

 

 

Document Template Creation

Block Scheme

Structural System

System Interactions

Physical Plates & Shapes

 

 

 

 

Creating small assembly templates

Splitting design into blocks

Creating structural systems

Connecting structural elements

Creating physical plates & shapes

  

Tools

For... See...



 

 

 

 

 

 

 

 

Project Management

 

 

 

 

 

 

 

 

Understanding project resource management



Block Toolbar

  

 

Building the block scheme

also covers   

Generating detail design blocks

  



Structural Systems Toolbar

  

 

Creating a plating system

Creating plating with free edge

Creating stiffening systems

Creating stiffening on free edge

Creating inserting systems

Creating openings

Creating beaming systems

Mitering

System split

Straking

Generating plates & shapes

  



System Interactions Toolbar

  

 

Automatically connecting structural elements

Manually connecting structural elements

Refining or modifying your connections

  



Physical Plates & Shapes Toolbar

  

 

Creating Plates

Creating Shapes

Creating Small Assemblies

Creating Cutouts

Placing Standard End Cuts

Placing Contextual End Cuts

Placing Slots

Placing Generic Slots

Defining Cutback

 Coping Plates & Shapes

Splitting Plates & Shapes

Merging Plates & Shapes

  



Tools Toolbar

  

 

Design Assistant

Naming section characteristics

  



Keyboard Shortcuts
Useful shortcuts for Ship Structure Detail Design commands are listed below. For general keyboard shortcuts, 
see the Infrastructure User's Guide.

 

Use this keyboard combination...  To run...

Alt + I + B Block commands

 + B the Block Scheme command

 + 3 the 3D Grid command

 + D the 3D Merge command

 + L the Block command

 + S the Split by Block command

Alt + I + S Structural systems commands

 + P the Plating command

 + L the Plating with Free Edge command

 + S the Stiffening command

 + T the Stiffening on Free Edge command

 + I the Inserting command

 + O the Opening command

 + B the Beaming command

 + M the Mitering command

 + R the Straking command

 + G the Generating Plates & Shapes command

Alt + I + Y System interactions commands

 + A the Automatic Connection command

 + M the Manual Connection command

 + C the Connection Body command

Alt + I + H Physical plates and shapes commands

 + P the Plate command

 + S the Shape command

 + M the Small Assemblies command

 + E the Endcut command

 + C the Contextual Endcut command



 + L the Slot command

 + U the Cutback command

Another useful shortcut

Clicking an icon runs the command associated with the icon once only. However, double-clicking an icon lets you 
use the associated command as many times as you want without having to repeatedly click on the icon.



Reference Information
Reference information that is specific to the Ship Structure Detail Design product can be found in this section.

User Features
Catalog Slots, Endcuts and Small Assemblies 



User Features
The information in this section concerns user features supplied with the Ship Structure Detail Design 
product that will help you in your design. 

In the Wireframe and Surface Design workbench (Start -> Mechanical Design -> Wireframe and 
Surface Design), select Insert -> Instantiate from Document... from the menubar, then select the 
user feature of interest.

●     CurveOrientation.CATPart to define a stable line

●     SurfaceOrientation.CATPart to define a stable surface

Features are to be found in folder 
..\OS\startup\EquipmentAndSystems\Structure\DetailingFeatures\SampleData.

CurveOrientation.CATPart

This user feature generates an oriented line (in bold blue) and two points, one at each end of the line. The 
start point is represented by a green circle and the end point by a white cross. CurveOrientation.CATPart 
has two inputs and one parameter: 

a. a curve or line you want to orient
b. a reference surface
c. a parameter determining line orientation by defining whether or not the starting point of the 
line is the nearest element to the reference surface. By default, the starting point is the point 
nearest the reference surface.



SurfaceOrientation.CATPart

This user feature generates an oriented surface (surface normal oriented in desired direction). 
SurfaceOrientation.CATPart has two inputs and one parameter:

a. a surface you want to orient
b. a reference point
c. a parameter determining surface orientation towards or away from (outward) the reference 
point. By default, the surface normal is oriented away from the reference point.

For more information, see Managing User Features.

  



Catalog Slots, Endcuts and Small Assemblies
This section contains information on parametric features (slots, endcuts and small assemblies) supplied with 
product and ready to place in documents.

T-Shape Endcuts
L-Shape Endcuts

Bulb-Shaped Endcuts
T-Shape Slots
L-Shape Slots

Bulb-Shape Slots 



T-Shape Endcuts

Name
 

Name
 

T-A49H T-E70LFH

T-A49SH T-E70LSH

T-A49XH T-E70LWH

T-A58H T-E70RFH

T-A70LSH T-E70RSH

T-
A70RSH

T-E70RWH



T-
A9NSSH

T-Endcut1

T-A9SWH T-F70CH

T-
A9XSSH

T-F70H

T-B55DH T-F70LFH

T-
F70LWH

  

T-F70RFH   



T-
F70RWH

  

T-X70LSH   

Parameters

Flange 
angle 
(P1)
Shoulder 
width 
(P2) 
Web 
length 
(P3)
Web 
height 
(P4)
Snipe 
radius/leg 
(P5)

Web angle (P6)

Flange 
length 1 
(P7)
Flange 
length 2 
(P8)
Cope 
depth 
(P9)
Cope 
radius 
(P10)

 



Cut 
height 
(P11)
Cut 
length 
(P12)

Cutout radius (P13)
Cutout half width 
(P14)
Cutout offset (P15)

Web 
height 1 
(P16)
Web 
height 2 
(P17)
Mouth 
length 
(P18)
Stock 
length 
(P19)
Relief 
radius 
(P20)

  

Curve 
radius 
(P21)

Flange offset (P22)
Shoulder width (P2)



L-Shape Endcuts

Name
 

Name
 

L-A49SH L-F70SFH

L-A58H L-F70SWH

L-A58TH L-FCOPEH-1

L-A70LSH L-FCOPEH-2

L-F70H   

Parameters



Flange 
angle (P1)
Web angle 
(P2)
Web length 
(P3)
Snipe 
radius/leg 
(P4)

 

Flange 
snipe length 
(P5)
Flange 
snipe width 
(P6)

  

Cope depth 
(P7)
Cope radius 
(P8) 
Cope length 
(P9)

 

Angle (P10)   



Bulb-Shaped Endcuts

Name
 

Name
 

HP_P0 HP_P24

HP_P5 HP_P26

HP_P6 HP_P27

HP_P14 HP_P29

HP_P15 HP_P41



HP_P17 HP-
ANGLH

HP_P18 HP-
ANGSH

HP_P19   

HP_P20   

HP_P23   

Parameters

Distance 1 
(P1)
Offset 1 
(P2)

Radius 
1 (P3)



   

Computed 
angle (P4)

  

Distance 2 
(P5)
Angle 2 
(P6)

Distance 
3 (P7)



T-Shape Slots

NamePublished
Parameters  

T-516 None  

T-520 None  

T-920 None  

T-921 None  

T-932 Snipe (P1)

T-933 Snipe (P1)  

T-938 None  



T-939 None  

T-940 Snipe (P1)  

T-941 Snipe (P1)  

T-941bSide clearance 
1 (P2)
Side clearance 
2 (P3)
Flange 
clearance 1 
(P4)
Flange 
clearance 2 
(P5)
Radius 1 (P6)
Radius 2 (P7)
Radius 3 (P8)

CC-10 
with 
angle

Side clearance 
(Sc)
Flange 
clearance (Fc)
Radius (R)
Angle (A)



RS-5 Radius 1 
(P12)
Radius 2 
(P13)
Side clearance 
1 (P9)
Side clearance 
2 (P10)
Side clearance 
3 (P11)

RS-6 Radius 1 
(P14)
Radius 2 
(P15)
Side clearance 
(P16)



L-Shape Slots

NamePublished 
Parameters 

 

CC-4 Snipe (P1)
Flange 
clearance (P2)
Radius (P3)
Side clearance 
(P4)
Angle (P5)

CC-5 Flange 
clearance (P2)
Side clearance 
1 (P6)
Side clearance 
2 (P7)
Radius (P3)
Angle (P5)

 

 

CC-6 None  



CC-7 Snipe width 
(P8)
Snipe height 
(P9)
Side clearance 
(P4)
Flange 
clearance (P2)
Radius 1 
(P10)
Radius 2 
(P11)

CC-8 None  

CC-9 None  



RS-3 Clearance 
(P12)
Radius (P13)
Snipe (P1)

RS-4 Side clearance 
1 (P14)
Side clearance 
2 (P15)
Side clearance 
3 (P16) 
Radius 1 
(P17)
Radius 2 
(P18)



Bulb-Shape Slots

Name Published 
Parameters  

HP_1230 Assembly 
clearance (P1)

HP_1232 Assembly 
clearance (P1)

 

HP_NR_900_ANone  

HP_NR_900_BNone  



HP_NR_900_CNone  

HP_NR_900_DRadius (P2)



Glossary

           

A
attribute Characteristics of an object such as thickness, material, throw orientation. Also referred to as 

properties.

B
beaming 
system A functional system defined by two intersecting planes and two limits.

block 
scheme Determines the basic block definition of the ship.

C
connecting 
system

Establishes functional connectivity between structural elements. Typical examples are plate to 
plate connections, plate to stiffener connections and stiffener to stiffener connections. Physically 
implemented downstream by means of joints and piece parts (chocks, transitions, brackets, 
etc.).

cutout The removal of a portion of a plating part, usually along one of its edges. Typical cutouts are rat 
holes and snipes. See also structural openings.

D



detail design 
block

A section of the ship generated by applying a block scheme block to the functional design. A 
block is a 3-D entity.

detail design 
view

The design view that documents a ship's structure in the 'as built' or 'as assembled' stage.

E
endcut A cutting detail. 

F
feature 
dictionary

The document in which object classes are managed.

free-edge 
stiffener

A structural shape used to stiffen the free edge of plating parts (i.e. part boundaries that do not 
connect to any other part). Typical examples are faces on free edges and coamings.

functional 
molded form

A functional surface derived from a conceptual surface. You can define more than one functional 
molded form from a conceptual surface.

I
inserting 
system

A special type of plating system.

M
molded 
convention

A set of rules that give default orientations when placing structural elements, thereby ensuring 
structural continuity. These conventions are described in an XML file reference in the Project 
Resource Management (PRM) file.

P
paneling 
system

The top level structure detail design object. This object contains a molded form and is created 
automatically when you create a plating system. It groups all plating and stiffening systems 
having the same molded form.

piece part Typically, chocks, transitions, brackets, etc.
plate A plate part is a part cut from flat raw material stock, which may later be rolled or bent to a non-

planar shape.
plating 
system

A functional system having a molded surface as support and defined by selecting limits, or limits 
and a free edge.

project 
resource 

Resources, like the feature dictionary, managed by system administrators in the Project 
Resource Management file.

property Characteristics of an object such as thickness, material, throw orientation. Also referred to as 
attributes.



S
section Describes the shape representation of a stiffening part.
slot A hole allowing penetration of another part.
standard 
part

Connections and joints. Typical examples are brackets.

stiffener A structural shape used to stiffen plating parts. Shapes are usually welded to parts they stiffen. 
Cross-sections can be selected from a catalog.

stiffening 
system

A functional system defined by a web support and limits.

structural 
openings

An opening in a host part to reduce weight, provide accessibility or allow penetration of another 
part. Typical openings are lightening holes, access holes and penetration holes. 

T
throw 
orientation

See molded convention.

trace Defines the path of a structural shape.



Index 

                   

Numerics
2D Grid command  

2D Merge command  

3D Grid command  

3D Merge command  

A
analyzing 

object relations  
applying 

block scheme  

attribute  

Automatic Connection command  

automatic connectivity  

B
Beaming command  

beaming system   

Block command  

block scheme  

applying  

building  

Block Scheme command  
building 

block scheme  



C
catalog  

endcut  

slot  

small assembly  
command 

2D Grid  

2D Merge  

3D Grid  

3D Merge  

Automatic Connection  

Beaming  

Block  

Block Scheme  

Connection Body  

Contextual Endcut  

Contextual Slot  

Cutback  

Cutout  

Design Assistant  

Endcut  

Generating Plates and Shapes  

Inserting  

Manual Connection  

Merge  

Mitering  

Name Section Characteristics  

Opening  

Plate  

Plating  



Plating with Free Edge  

Shape  

Small Assemblies  

Split  

Split by Block  

Standard Slot  

Stiffening  

Stiffening on Free Edge  

Straking  

System Split  

connecting system  

Connection Body command  
connectivity 

automatic  

connection body  

manual  

modifying  

contextual endcut  

Contextual Endcut command  

contextual slot  

Contextual Slot command  

coping  
creating 

catalog  

catalog endcut  

catalog slot  

catalog small assembly   

opening  

plate  

plating system  

plating with free edge  

shape  



small assembly  

stiffening on free edge  

stiffening system  
customizing 

standard views  

Cutback command  

cutout   

modifying  

placing  

removing  

Cutout command  

D
Design Assistant command  

detail design block   

detail design from scratch  

detail design view  
document templates 

small assemblies  

E
editing 

plating system   

plating with free edge  

stiffening system  

endcut  

catalog  

contextual  

standard  

Endcut command  



ENOVIA LCA integration  

recommended methodology  

workpackage  

F
feature 

contextual endcut  

contextual slot  

cutout  

standard endcut  

standard slot  

feature dictionary   

free-edge stiffener  

functional molded form  

G
Generating Plates and Shapes command  

I
Inserting command  

inserting system   

interoperability with ENOVIA LCA  

K
keyboard shortcuts  

knowledge expert  



M
Manual Connection command  

manual connectivity  

Merge command  
merging 

plate  

shape  

Mitering command  
modifying 

connectivity  

cutout  

merge plates and shapes  

split plates and shapes  

standard slot  

trim shape  

molded convention  

molded conventions  

N
Name Section Characteristics command  

naming rules  

O
object naming rules  

object relations  
opening 

catalog  

creating  



parametric contours  

positioning strategies  

Opening command  

opening system  

openings catalog  

Options settings  

P
paneling system  
physical plates and shapes 

generating  

piece part  
placing 

contextual endcut  

contextual slot  

cutout  

standard endcut  

standard slot  

plate   

merging  

modifying and deleting cutouts  

modifying and deleting slots  

splitting  

Plate command  

Plating command  

plating system  

creating  

editing   
plating with free edge 

creating  

editing  



Plating with Free Edge command  

project parameters  

project resource  

project resource management  

Access field  

file  

Location field  

selecting project  

Type field  

Visible  

property  

publication based connections in PRM  

R
related objects  
removing 

cutout  

standard slot  

S
section  

characteristics  

shape  

merging  

modifying and deleting cutouts  

modifying and deleting slots  

splitting  

trim to plane  

Shape command  



slot  

catalog   

contextual  

standard  

Small Assemblies command  

small assembly  

catalog  

creating  

Split by Block command  

Split command  
splitting 

plate  

shape  

standard endcut  

standard part  
standard slot 

modifying  

placing  

removing  

Standard Slot command  

start from scratch  

stiffener  

Stiffening command  
stiffening on free edge 

creating  

Stiffening on Free Edge command  

stiffening system  

creating  

editing  

mitering  

straking  

merging grid cells  

Straking command  



structural openings  
system 

beaming  

generating plates and shapes  

inserting  

opening  

plating  

plating with free edge  

split  

stiffening  

stiffening on free edge  

straking  

System Split command  

T
throw orientation  

trace  

trim to plane  

U
user features 

catalog  

CurveOrientation.CATPart  

endcuts  

parametric contours for openings  

positioning strategies for openings  

slots  

SurfaceOrientation.CATPart  



W
workpackage  
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